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第一章  概述 

1.1 系统登录界面  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
User name  (用户名)-------英文名前三位+姓的前三位（酒店自定义） 
Password   (密  码)-------ihg123456    (酒店自定义的默认密码) 
Schema    (系统环境)---- OPERA@opera   (酒店正式系统) 
                       TRAINING       (培训系统)  

SIMULATION   （测试系统） 
在系统登录界面里输入 User(用户名)→Password(密码)→点击“Login”→进入系统主界面。如图 

1.2 系统主界面 

Log in -----进入系统 
Log off -- -退出系统 
子系统如下： 

  PMS：酒店管理系统  
        前台操作系统 
  End of Day：夜审系统    
  OXI：Holidex 
  Utiliies：系统管理 

系统维护工具  
  Configuraton：设置  
 
 
 
 
 
 
 
 
 
 



特殊键及系统默认说明 
 ALT+带有下划的字母（注：在下拉菜单中可以直接按带下划的字母）。 
 “Tab”-----下移动单元格；    “》&《”-----翻页；         “Shift＋Tab”-----上移动单元格； 
 “F9”-----下拉菜单           Spacebar (as mark key) -----选中（键一次）/不选（再键） 
 “&<”-----移动单元格；      “F8”----为切换用户的快捷键。 
 Opera 里蓝色为必填栏，黄色为查询框，红色为多重信息，Opera 里没有双击键。 
 在信息录入界面：用 Tab 键向前进格； Shift+Tab 向后退格；  
 日期输入格式为“月-日-年”，输入 030204，输完用 Tab 键移开；  
 输入日期比当前系统日期晚，系统默认为当月该天；输入日期比当前系统日期早，系统默认下月该天；  

 F9 打开下拉菜单选项，用上下键选择，回车选中；Esc 取消； 
 F1：在线帮助、用户手册； 

1.3 操作系统登录    点击相应子系统图标进入。如:PMS----进入前台操作系统 

注：第一次登录系统要求修改密码(如图)，规则如下： 

1、字母+数字组合（6 位）； 

2、不能使用和用户名相同的； 

3、不能使用前四次的密码相同， 

4、60 天更改密码（30 天开始出现提示信息,如图）。未到 60 天的用户名更改密码的方法:“Miscellan”

→ “change password”进行更改  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

            密码到期提示信息 
 
 
                                                                                                      
                                                        

 密码必须包含字母和数字。  
 密码长度必须大于 6 个字符。  
 密码不能是过去 4 密码使用。  
 密码不能类似的用户名。  
 请选择一个新密码。 

                                                           
                                                           
                                                           



1. 4 操作主界面 
 

 

 

 

 

 

 

 

 

 

 

 

 

横向图标功能组： 

 Reservation-------------------------------------------------预定；  
 Front Desk--------------------------------------------------前台；  
 Cashiering--------------------------------------------------收银；  
 Room Management---------------------------------------房务；  
 AR-----------------------------------------------------------应收；  
 Commissions-----------------------------------------------佣金；  
 End of Day-------------------------------------------------夜审; 
 Miscellaneous----------------------------------------------杂项；  
 Setup--------------------------------------------------------设置； 
 Back Office Interface -------------------------------------后台接口; 
 Help---------------------------------------------------------帮助; 
 Exit----------------------------------------------------------退出; 

注：菜单栏：与横向图标功能组的内容相同。 

1.5  操作常用选项 
New—新建； Edit—编辑； Change—更改； Search—查询； Save—保存 

Close—关闭； OK—确定； Options—选项； Find—查找； Clear—清除 

Detail—详细； Delete—删除； Cancel—取消； Return—返回 

Last Resv.—操作员本人最后建立的预订；Preview—预览； Print—打印 

Refresh— 刷新   Report—报表  File—文件 Revenue—收益 
 
 
 
 
 



第二章 Profiles 档 案  

Profile-------档案资料，系统里所有操作的基础。  

2.1   档案类型   （如图） 
 
 Individual………………..个人 

 Company………………...公司 

 Travel  Agent…………..旅行社 

 Source…………………...订房中心 

 Group……………………团队 

 Contact …………………..联系人(客户的联系人) 

2.2   新建档案  

方法：1、在 Profile Search 查询窗口中先选择档案类型，再按“New”。(如下图) 
             Reservation→Profile→选择 View By  (查看类型)→New 

         2、在 Profile Search 查询窗口中先按“New”，再选择档案类型。（如上图） 
Reservation→Profile→New→选择档案类型→OK 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
                           (View By 查看类型) 
 

注意：在新建档案时应“先查询后新建” 
 
 
 
 
 
 
 
 



2.2.1 Individual--------个人档案 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Last Name   姓：首母要大写。 

点击“       ”里可以输入多重信息， 

也可以输入中文但不显示。 

 
 First/Middle  名：首母要大写。两字以上可用空格分开，如：You Ping 。  
                                                   

同时可在中文名（指拼音）前加英文名以空格分开。如：Barlow You Ping  

 Language/ Title  语言/称呼：语言。同时控制打印帐单、叫早服务等其它功能的语言。 

 Address     地址：可以多重输入。 

点击“     ”，new→选择地址类型， 

Business Address------工作地址： 
Billing Address--------帐单地址  
Home Address---------家庭地址 (默认) 
Mailing Address-------邮件地址 
Shipping Address---- 航空地址  
Po Box----------------邮政信箱 

→OK→Address(地址)→City（城市） 

→Postal Code（邮编）→County（国家）→Stats（省）→Primary（优先权）→OK 

档案主页上显示的是 Primary 地址，要将地址显示在档案上的操作：→选择要显示的地址→点击 

Primary (选中的地址会带个号)→Close 。 

 Home address   字体为蓝色表示与上一框链接，上栏输不下可以在此栏输入。 



 City-----城市； Postal code/Ext-----邮政编码/区号（一旦输入，省份自动显示）  

 Country/state-------国家/省份 

 Communications------通信工具 电话号码的国家代码、区号去除首“0”，中间以空格相连。 

点击“        ”，会出现 Communication Type 对话框。如图 

     HOME：家庭电话号码 

     BUSINESS：公司电话号码 

     WEB：网页 

     MOBILE：移动电话号码 

     FAX：传真号码 

     EMAIL：邮箱地址 

     HOTEL：居住地址 

      点击“        ”，会出现 Communication Information 文本框。如图 

 

 

Show Primary Only： 

只显示优先权选中 

的信息记录。 

 

 Salutation：赞扬词（如：向 xx 先生或女士致敬）。在填写了 Title（称呼）后，系统会自动生成。) 

 Vip：Vip 类型选择       

VIP 1 PC Base,Freq Guests,Long Stay 

VIP 1 普通会员，常客，长住客 

VIP 2 PC Gold,Special Freq Guests,Diplomats 

VIP 2 黄金会员，特别常、长住客，外交官 

VIP 3 PC Platinum,Top Freq Guests,Celebrities 

VIP 3 白金会员，超级常、长住客，名人 

VIP 4 Heads of State,Royalty                 

VIP 4 国家元首，王族（成员） 

VIP 5 Gold Ambassador                     

VIP 5 黄金大使 

VIP 6 Platinum Ambassador                  

VIP 6 白金贵宾大使 

VIP 7 Royal platinum Ambassador            

VIP 7 皇家白金贵宾大使 

 



 VIP reason；VIP 理由; 原因       

 Pref. room：喜欢的房间或房间类型 

 Other 1 ：其它输入框 1（酒店自己定义）         

 Other 2 ：其它输入框 1（酒店自己定义） 

 Date of birth：出生日期  输入方式：日/月/年 注：1949 年（包括 49 年）以前出生的，年份不能简写。 

 Nationality：国籍/民族 

 Passport：护照号 注：签证/签证有效期/身份证号码 

 Mailing list□Mail_list  (是否有酒店派送的礼物)  

客人要求邮寄的信息□客人是否要求邮寄酒店相关信息 

 Active：活泼的, 主动的； 

 History：是否保留档案。打√保留，不打√则一段时间后系统自动删除。） 

 Keyword：关键词   点击“      ”，会进入 Profile Keywords 文本框。如图 

Keyword Type： 

  ABBR：公司名字缩写 
 CPI ：公司标识 
 Master _Account： 
公司协议帐号 

 

 

 

 

 Contact：联系人选中此选项会进入 account search 对话框，进行客人关联操作。如图 

    

 

 

 

 

 

 

 

 

 

 

 

Relationship-------关系、关联（公司与公司的关系；公司与个人的关系）。 

 



 Notes：客人信息备注（用来输入客人的特征和喜好）    

    Note Type：备注类型 

Backgroud Notes------职业备注 

Central Comments-----主要的备注 

会连到 PMS。其它的不会。 
General Notes--------- 一般的备注 

Outlook Notes----------观点喜好 

Web Notes--------------网络信息备注 

Property Notes---------属于本酒店 

Reservation Notes：预订备注；注：只有 Reservation Notes 可以复制到预订上的备注中； 

 输入或拥有多种备注时，在Profile 下栏有红灯提示，可以双击显示所有内容； 
 常用的备注为Reservation 与General ，而须知晓的是，Reservation Note 是可以保留至Future 

Reservation 中的。 
注：Note 文本框中最好输入日期和姓名,以便管理。 

点击“     ”对话框时 New 选择 Notes Type------Central notes 会连到 PMS，其他的不会。 

新建 Notes：  

→New→Note Type：备注类型 。如图 

→Internal Only：打√只想内部的人知道，可控制是否打印； 

→Global：打√自动复制到所有酒店，对所有酒店公开，否则只能选择其中一家酒店，规定：酒店

的协议单位的 Notes 不得勾选 Global；(本酒店还没有开通) 

→Title：标题可以自己输入，也可以与 Note Type 可以相同。如图 

 

 

 

 

 

 Attributes----------------客人信息                   History information------历史资料 
Rate code ----------------------------价格代码            Last Room------------上次房间 
A/R No.------------------------------应收代码             Last Rate--------------上次房价 
Member No.------------------------会员号               Last Visit--------------上次日期 

 Search name：查询姓   

 First       ：次数 。 如图 
在查询框中输入条件， 

直接按回车。不要按 “Search”键 。 
红色条表示有重要信息或多重信息 

 

 

 



 More Fields：更多栏位。点击出现“More Fields”对话框。 
 

 

 

 

 

 

 

 

 Statistics & Info：客人统计资料信息。点击出现“Statistics & Info”对话框。 
记录近两年客人在酒店的入住信息 

Room Nights---------住几晚 
Arrval Rooms--------到达房间数 
Cancel Rooms--------取消房间数 
No show Rooms------预订未到 
Day use Rooms-------当日抵离 
Total Revenue---------总消费 
Room Revenue--------房间消费 
F&B Revenue---------餐饮消费 
Extra Revenue---------额外消费 
Non Revenue----------承包部门消费 
Res. Nights-------------预订住宿天数 
Res. Arrirals------------预订次数 
Cancel Res.-------------预订取消次数 
No show Res.-----------应到未到次数 
Day use Res.------------日用房次数 
         (钟点房、半日租) 

Status---------黑名单 
Resertcted----受限（勾选项） 

Language--------语言 
A/R No.----------应收账号 

 档案页面左上方 如图 

 

Save 或 OK 后出现 ID 号，为电脑自动生成编码（唯一的），不能作为查询条件。 

 档案页面下方 如图 

 

 

Created By：创建人；    On：时间； At：操作酒店代码 

Update By：最后修改人； On：时间； At：操作酒店代码 

 

 



2.2.2 Options： 功能选项 

Changes---------------更改 
Credit Cards---------信用卡 
Delete------------------删除 
Enrollment-----------申请会员 
Future-----------------将来、前景 
History----------------历史资料 
Lookup----------------找寻 
Memberships--------客户信息 
Merge-----------------合并 
Neg. Rates-----------合同价 
Notes-----------------客人信息备注 
Rreferences---------客人喜好 
Relationship--------关系、联系 

2.2.2.1 Changes---------修改记录 

 

 

 

 

 

 

 

 

 

 

 

2.2.2.2 -------------Credit Card 

信用卡资料，可将客人常用的信用卡的资料保留在档案中；  

 

 

 

 

 

 

 

 

 

 

 



2.2.2.3   Delete  删除档案  

2.2.2.4   Future   将来预订信息  

 

 

 

 

 

 

 

点击“new”, 出现“rate query”对话框（如图），可新建预定  

2.2.2.5    History 历史信息   在店客人统计在 History 中。 

 

 

 

 

 

 

Stay Info：客人详细记录        Revenue：消费金额汇总（每次），完整保留。 

 

 

 

 

 

 

 

 

 

 

 

 

 

New----可以新建客人的详细记录 

Summary---摘要  Points---要点  Resv. ---预定  View Folio ---查看明细帐单 



2.2.2.6 Membership  会员 

→Memberships(出现 Membership List 对话框)→New(出现 Memberships 对话框)。如图 

Type：会员卡类型；散客卡、协议卡  

Card Number：卡号；  

Name on Card：持卡人姓名；  

Level：会员卡等级；金卡、白金卡等；  

Expiration：有效期；  

Sequence：序号；  

Member Since：开始日期；  

Comments：备注；  

Inactive：会员卡是否有效。打勾代表卡无效；  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

在 Pfofile 查询界面里，右侧有“Enrollment”和”Lookup”按键。点击会出现相应的对话框 

 

 



2.2.2.7 Merge 合并档案 

点击”Merge”进入“Profiles Search”对话框（标题栏中多“Merge”字样）， 选择记录单击OK，出现 “Profiles 

Merge”对话框，点击“Merge”,出现合并信息进度条及完成对话框。先打开的被保留，后打开的被合并。 

 合并前提必须是同一类型档案。确认需合并档案，选定完整档案，合并缺失不全的档案，多种选项 
区域内容将一并保留，如：Address 与communication 栏，合并后的档案是以完整档案为主的。 

操作：打开第一个档案→Options→Merge→Name（输入要被合并的档案的名字）→Search→选择

要被合并的档案→OK→Merge。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

注：合并界面上左边的（Profile to Merge） 

为被合并档案，右边(Original Profile) 

为要保留档案。合并后所有历史和将 

来的数据以及客人的联系方式等都将 

会被合并。                                        完在对话框  

 



2.2.2.8 Neg. Rates 连接协议价格代码 

      点击出现“negotiated tates”对话框 ,可以”New”。如图所示，根据房价代码，选择销售开始时间和

销售结束时间，点击 OK。show inactive---显示无效的记录。 

 

 

 

 

 

 

 

 

 

 

 

如果要结束给予协议公司的协议价格则必须在 End Sell Date 中输入相应的结束时间。   

                 Detail-----详细    点击“Detail”会出现“rate setup edit”窗口。如图 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Rate header 栏   Negotiated 栏：（点击“profiles”可以打开“company profiles”对话框） 



2.2.2.9 Notes   客人信息备注     与主界面上 Notes 同。  

根据客人的喜好录入，但是不能跟预订走。 

2.2.2.10 Preferences  喜好  

     客人的普通喜好( 客人的一般喜好，如：楼层、房型等)  

Preference Group：喜好类型           Preference：喜好  

→FLOOR(楼层喜好)→选择楼层→OK 

→ROOM Features(房间特征)→View  

   Lake→OK 

→SMOKING(吸烟喜好)→ 

  NON-Smoking\Smoking Preferences 

  →OK 

 

 

 

2.2.2.11 Relationship 关系、联系  （用于建立档案之间的联系。） 

      点击进入“profile relationship”对话框，“New”会出现“profile type”对话框、如图，选择类型进

入 “ relationship type”对话框、如图，确定关系进入 “profile search”查询框、如图，找到对象，点击“OK”

完成。 如图 

 

 

 

 

 

 

 

 

 

Company------Employee（公司-----雇员） 
Employee----- Employer (雇员------雇主) 
Company master-------总公司 
Compay.Subsidiary----分公司 

当在 Individual 界面里时，选择“Individual/contact”时 

会出现错误信息（没有任何关系类型与之相符） 

 

 



2.2.3 新建公司档案 

Reservation→Profile→New→Company(公司) →OK 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Account：公司名称。  

注：只有第一行可用作查询，完整名称输在第一行，第二、三行输入备注说明。  

Address：地址。具体操作与个人档案上的 Address 操作同。  

City: 城市； Postal code/Ext-----邮政编码/区号      Country/state-------国家/省份 

Corporate ID：公司号，自己设定标准输入，可用作查询（Corp. No.）；  

Active：有效，激活；选√表示该档案有效，不选为无效，档案状态变为 Inactive；  

注：当要删除公司档案时，不能直接用 Delete 删除，不然会使统计数据无法查询，只要把状态

改为 Inactive 即可。  

Routing：行程按排。 

Communications：联系方式；与个人档案同； 

Owner: 酒店销售经理 

Contacts：连接“Contact Search”查询框。 

Potential：连接“Potential Search Screen”查询框 

E-Mail：连接“E-Mail”(要先进行初始化定义)。 

 

 



 Stats & Info：额外数据； 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Statistics this Year 与 Last Year：与个人档案同 

Status：信用情况。 Normal：信用良好（默认不显示）； Restriction：信用有限制。Rule：描述受限原

因，简短提示语，该提示语会在客人预订入住时自动跳出。  

A/R NO：应收账号。  

Potential Rm. Ngts.：合同中至少房夜数，与左边实际发生做比较；  

Potential Revenue：合同中至少消费额，与左边实际发生做比较； 

 Sales Info：销售数据（Sale Info（可以更改信贷信息）） 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



2.2.4 公司 Options 标准说明  

 

 

 

 

 

 

Notes：备注；  举例说明仅供参考（协议公司备注输入类型为 General Notes。输入格式为： 协议号：

联系人： 折扣： 签单人： 酒店销售经理： 合同有效期） 

注：酒店不需要将协议信息备注共享给其它酒店。  

Neg. Rates：协议价。   （最好定为：协议公司连接协议价。）  

Overview：信息；如图 

 

 

 

 

 

 

 

 

 

 

 

 

 

上下两部分代表团队与散客的信息。  

 Rollup Sub-Account Statistical: 汇总分账户统计 

 Include Legacy/Manual Statistical: 包括遗产/手工统计 

 Block Summary:团队信息 

 Individual Summary:散客信息 

 Rooms Currency: 客房币种 

 Catering Currency: 餐饮币种 



2.2.5 新建旅行社档案 

Reservation→Profile→New→Travel Agent(旅行社) →OK  

 

 

 

 

 

 

 

 

 

 

 

界面与公司档案同，可参考公司档案； IATA：国际名称，可用作旅行社编号；  

 Stats & Info  如图 

 

 

 

 

 

 

 

 

 

 

 

 Back Account：佣金；如图 

→Back Account(选账户，默认人民币)如图  

→Commission Code（选比例）如图 

→OK  

Commission Code：佣金比例，针对所有账户；  

注：Neg. Rate（协议价）中的 Commission Code（针对该价格）优先级高。  

Sales Info：销售数据(同与公司档案)。在“options”有“commission----返佣”界面 

 

 



 

 

 

 

 

 

 

 More Fields:更多选项 

 

 

 

 

2.2.6 新建财务/订房中心档案 

Reservation→Profile→New→Source(订房中心) →OK 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

界面与公司档案相同，可参考公司档案； Corporate ID：社团的、法人的账号 

Stats & Info 与公司档案相同； Sales Info 与公司档案相同； 在“options”有“commission 返佣”界面 



 More Fields:更多选项 

 

 

 

 

 

2.2.7 新建团队档案 

 

 

 

 

 

 

 

 

 

 

 

 

2.2.8 新建联系人档案 

必须有一个公司的档案，在此基础上可以新建→查询帐户名称→选择帐户→OK 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

Internal Information 

(酒店)内部的信息 

Personal Information 

个人的、私人的信息 

 

 

 

 

 

Sales Info：销售数据 

 

 

 

 

 

 

 

More fields：更多选项 

 

 

 

 

 

 

     Routing Instructions:行程按排指示。（下拉框为“transaction codes”框） 

 

 

 

 

 

 

 

 

 

 

 



Individual：个人档案(连接“Individual Profile“界面) 

 

 

 

 

 

 

 

 

 

 

 

注意事项： 

1 、系统默认自动保留History, 如果此History 不需要保留，请将History 的 ‘√’点掉。

系统默认在Active 上打勾，如果以后不需要再使用客史，请将Active 的“√ ”点掉。 

2 、City 均输拼音或英文。 

3 、建立公司或旅行社时，如该公司为分公司，则将地名输在公司名的后面，如无分公司，

则地名输在公司名的前面。 

4 、Credit Card / Negotiated Rate / Preferences 三栏目内容可以保存至Future Reservation 。 

5 、档案查询操作界面切换时出现灰色界面呈不可键入状态，此为提醒多重界面已经点    

开，点托开当前封面界面即可。 

6 、日期的输入喜达屋标准为“月、日、年 ”。 

 

 

 

 

 

 

 

 

 

 

 

 



2.3 档案查询       Reservation→Profile  

2.3.1 在查询界面进行查询  

在新建 Profile 时，应先进行档案查询，避免出现重复的 Profile 信息。  

进入方法：1、Reservation →Profile，会出现“profile search”查询框。如图  

           2、ALT+R 在出现下拉菜单时按“P”键，会出现“profile search”查询框。如图  

 
 
 
 
 
 
 
 
 
 
 
 
 
黄色区域为查询区域：可以具有单项、多项的查询条件。 

方法：输入查询条件→选择“Search”按键。“Clear”：清除查询条件及内容。“%”为查询条件的通配符。 
Name---姓    First Name---名     View By----查看类型  Enrollment----申请会员。{需接入 PMS}  
Lookup--------搜索是否是会员。   {此功能在接入 PMS 中央预定系统时用上} 
Resv.  --------查询预订信息。点击“Resv.”会出现“Rate Quer”对话框，可以看见客人的预订信息， 
            在对话框中点击“List Resv.”会进入预订单界面。 

2.3.2 在档案界面进行查询 

打开的档案界面→输入 Search Name→按 Tab 键→选中要查看的档案名 

 

 

 

 

 

 

 

 

 

 

(如在新建档案时建立了“%”为 Last Name 的档案，可在档案界面的搜索界面中找到。) 

 

 



第三章  Reservation 预 订 

3.1  预订概述 

 

 

 

 

 

 

 

 

 

 

 

New Reservation---------------------------新建预订 

Update Reservation------------------------更新预订 

Blocks-----------------------------------------团队锁房 

Wait List--------------------------------------等候名单 

Profiles----------------------------------------档案 

Room Plan------------------------------------房间平面图 

Floor Plan-------------------------------------楼层平面图 

Confirmation---------------------------------预订确认信 

Calendar---------------------------------------日历 

 



3.2  新建预订 (Reservations→New Reservation) 

3.2.1 散客预订  

方法一：直接点击 F5→“Rate Information”查询对话框。如图    

Rate Query---------------价格查询  

Rate Lookup--------------会员价格查询  

Package Elements---------包价查询  

（房价是否包含其它的费用） 

Rate Availability Grid---房价表查询 

Item Inventory------------HSKP 的租借查询  

          选顶分类说明: 

 Rate Query---------------价格查询。见“方法二中的”Rate Query“框 

 Rate Lookup--------------会员价格查询 

 

 

 

 

 

 

 

 

 

 Package Elements---------包价查询 

 

 

 

 

 

 

 

 

 

 



 

 Rate Availalility Grid----房价表 

 

 

 

 

 

 

 

 

 

 

 

 Item Inventory------------HSKP 的租借查询 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



方法二：直接点击“New Reservation”→“Rate Query”对话框。 

此查询框可以了解客人入住信息： 

姓名、证件、入住日期/离店日期、入住 

人数、支付方式、房型、给客人的价格、 

会员卡、住宿天数（晚/数）、公司信息。 

必须填写：Arrival---到店日期 

Night---晚数 

          Departure --入住期限 

Adults---成人数 

Children---儿童数 

Name：先输“姓”再输“名”中间有“，”隔开。 

如：Liu,Lynn（如果不这样输入再进入下对话框时 

不会自动分行）→点击“OK”→进入 “Profile S 

earch”对话框→点击“OK”→进入“Rate Query  

Details”对话框，如图。 

输入姓名→下接菜单→  

 已有档案：选择正确的 Profile→OK 

 没有档案：New→输入档案内容 

 

→Rate Code：价格代码；→OK→进入价格列表 

 右面功能键介绍： 

Overbooking----超额预订 

Item Inv.--------- HSKP 的租借 

Waitlist----------备用预订 

Rate Info--------房价组成 

Analyze---------房间代码分析 

Long Info-------价格详细说明 

Scope------------返回上一步 

Average Rate-------平均房价 

Total Rates----------总房价 

First Night-----------首晚房费 

Closed----------------显示被关闭的 code 



 Room Types 房型： Include  overbooking: 超额预定； Physical  Inventory: 酒店可卖房数 

                        Back  Rate: 门市价（散客）  ； Training Use：合同价 

                        Advance Purchase ….：          Training Use Only: 

 勾选功能：Average Rate：平均房价  Total Rates：所有房价  First Night：首晚房价   

Closed：已经停用(被关闭的 code)  Negotiated：协议价格  Day Use：显示日用房 

注：Day use------显示日用房（新建预订才会显示），此对话框可以从预订的“Rate Code”进入。 

→选择符合要求的房间类型→Res. → 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 具体步骤：点击“New Reservation”→出现“Rate Query”界面→填写 Arrived Date （到达日期）、

Nights( 住几晚)、Name(客人姓名)、Company（选择公司）、Agent(旅行社)、Source(来源)等信息

→点击“Ok”→进入“Profile”→Name(英文及汉语拼音)→First Name(英文及汉语拼音)→View By栏目

选择 Individual－如果之前已经建有档案，选择 Ok,如果无选择 New Profile(新档案)→建立档案后

Ok 后，→进入房费代码接口（Rate Query）选择相应的房费代码和房型，→点击 Reservation→进入

Reservation 界面，补充相应的 Source（来源）、Payment（付款方式）→点击 Save→Close 即完成。

如图:(上面的部分均自动转自 Profile) 
注：输入入住时间后，如果先点击入公司名的话，我们可以看出房间状况，红色为订满， 绿色为可销

售，因此我们需先输公司名再输客人名字。选择相应 Rate Code，查询框可条件选择明细，推出接口选

择 Scope 键。  

 界面具体说明： 
 客客信息: 

 Country:国家  Lang: 语言  Name:           姓氏  
 Pre`d Room:喜欢的房间号码   First Name:名字 Title:头衔  
 Last Stay:上次入住时间  Phone:          电话   
 Agent:         旅行社    Member Type:会员类型 #：会员号码 
 Company:      公司    Level: 会员级别 VIP:贵宾 
 Group:         团体     Address:地址 
 Source :        财务/订房中心   City：城市 
    Zip/State: 



  More Fields: 
 Arrival Date:   抵店日期   
 Nights:         入住几晚  
 Departure: 离店日期  
 Adults:入住成人数 Ghild:儿童 

No. of Rms:房间数   
 Room Type:房间类型代码 RTC－

Rate to Charge:应收价钱的房型代码 
 Room:房间号码 Features: 
 Rate Code:房价代码  

DNM □ :锁定房间(不能换房) 
□ Fixed Rate:固定房价   

 Room Rate: 房价  
 Packages:  包价 Curr.：币种 
 Block Code: 团队锁房代码  
 ETA: 预抵时间 C/0 Time:预离时间    
 Res. Type:预订类型  
 Market:市场代码  
 Source: 订房来源代码   
 Original:       订房途径   
 Payment:      付款方式    
 Credit Card No.: 信用卡号码 

 Expired Date: 有效期  
 CC Holder: 
 Booker Name: 
 Booker Details: 
 No Post □: 营业点可否入房帐选项 

Send Confirmation □ 

 Print Rate □ 保密房价选项 
Video C/Out? □ 

 GRS No.: 订房中心号码    
 Discount Amount / % :  

折扣金额 / 百分比 
 Reason:  折扣原因 
 Specials: 特别要求 
 Comments:  备注 
 Item Inventory: 借用物品 
 Extra 1:酒店自定义 1 
 Extra 2/3：酒店自定义 2/3 
 Folio Balance: 客人帐单余额 
 Approval Amount: 预取授权金额    
 Approval Code:预取授权号 

 Upgrade 的房型设定为第一位(左边-实际入住的房型)，第二位（右边-实际收费价格的房型）为原  
       来的，必须有原因输入。 

 Rate Code:一旦选定，连接带出设置好的相应 Market Code。 
 选定的 Rate Code 为 Package Rate 时，“Package”栏目蓝色显示。 
 Room Rate：可以 Refresh 或者点击价格单元格直接更改（权限限制）。 
 Room Type:房间类型代码(客人实际入住的房型) 
 DNM □ :DNM 为”DO not move(请勿换房)”的缩写,锁定后房间号就成红色. 
 ETA: 预抵时间 (当系统 check in 时,就成了入住时间)   
 C/0 Time:预离时间(当系统 check out 时,就成了结帐时间) 
  Block Code 栏可以直接连接，将 Individual Guest 添加入团体中。 
  Fixed Rate:栏默认空白，一旦选上，房价被固定了，将不可在 Package 、Discount、Multiple Rate 

三栏目作任何有关价格更改的操作 
实际价格与规定价格不相同时,会”√”。当免费升级时 Room Type 与 RTC 才会不同。 

 Room：出现房间号。证明已排房，反之没有。 
 付款方式选择为现金时，Comments 栏须输入“POA－Paid Own Account”,信用卡接口呈阴影（不

可操作状态）；选择信用卡时必须输入相关信用卡信息（信用卡号码，有效期，授权号，授权金额）。 
 Discount:金额输入负数金额可以记录为 Upselling。 
 Special:栏信息可以带入 Profile Preference。 
 Comments:栏会有 Profile Note 信息栏内容反映，一旦输入多项信息，此栏显示黄色。 
 Item Inventory：客人借用物品记录，适用与 Housekeeping，快捷键 F5 可以操作。 
 No Post ：营业点可否入房帐选项   

    注：”No Post” 视客人押金是否足够而决定客人可否在营业点挂房帐；营业点收银员在入房帐时遇

到大额度的账单需电话咨询前台 
 Print Rate：保密房价选项  
 Res. Type：预订类型，默认为“1”，必须根据实际情况选择预订类型；必输项；  
 Market：市场代码；根据所选的价格代码自动显示，可根据实际情况改动；必输项；  
 Source：来源，客源；必输项；  
 Origin；客人订房途径；必输项；  



 Credit Card No.：信用卡号；付款方式为信用卡时为必输项；  
 Exp. Date：有效期至；付款方式为信用卡时为必输项；  
 Approval Code：授权号；显示最后一笔授权的授权号；  
 Approval Amt:授权金额；显示所有授权金额的合计；  
 Folio Balance：到目前为止消费余额，系统显示；  
 Reason：原因；特批价原因，打折原因等；如为特批价时为必输项；  
 Discount Amount / % :折扣金额 / 百分比    (3.2.4.2 免费升级) 

 Rate □      点击….进入下图： 
 

 Refresh Rates：刷新房价（修改房价后一定要刷新） 
 Daily Details：房价明细 
 Rate Info.：房价信息 
 Short Info.： 

 
 
 
 
 
 
 

      Daily Details：房价明细 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

     Rate Info.：房价信息 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



    Short Info.： 
 
 
 
 
 
 
 
 
 
 
Specials：特殊要求； 早餐的份数(Y1\Y2….)，免费升级的原因(XO\X1)等等。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

注：宾客档案中的 Preferences 中的 Specials 会自动放入预订接口上的 Specials；预订新加的 
Specials 系统会提示是否加入档案中，可根据情况选择；  

 Packages：包价；价格内包含项目将不显示在主接口上； 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Package：包价 
 Quantity：数量 
 Exclude：扣除 
 Posting Phythm：过账期间 
 
 
 
 



 
Comments：    备注；操作：下拉菜单→New→Comment Type（选择备注类型）  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 CASHIER             Displayed on billing screen：在账务接口上显示；  
 IN HOUSE            Displayed after check in：在入住后显示；  
 RESERVATION        Displayed prior to check in：在入住前显示： 
→输入备注内容→OK→Close. 注：每个预定中每种 Comments 只能有一条。  

VISA Type：签证类型；  
VISA Exp.：签证有效期；  
Member #：会员卡卡号；如该客人为金爵会协议卡消费，并可享受积分时为必输项；  
No Post：签单控制，√表示不能签单，NCR 系统中客账不能传入 OPERA 系统客人账单中；  
Print Rate：打印价格，√表示打印价格，默认打√； 

→Save →出现该预订的预订号（唯一的，要求记录） →OK→OK 
 
 
 
 
 
 
 
 
 
注：Comments 变黄色，表示有两个备注或以上；  

Member type 变黄色，说明有两个会员号或以上； 
RM. Type/RTC： 左：实际入住的房间类型； 

右：预订时的房间类型；价格参照右边，用作免费升级。  

 预定状态: 
 
 
 
 Reserved: 预定（未到的普通预定）           Walked in:  无预定的散客(已在店) 
 Due in:   当日预抵未抵                     Due out:    当日预离未离 
 Checked in: 入住（在店）                   Check out:   已离店 
 No show:  应到未到                        Cancelled:   取消预定 



3.2.2 公司、旅行社散客预订 
在新建预订的第一个接口中连接 Company 协议公司档案或 Agent 协议旅行社档案、同时

连接 Source 销售员档案。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

OK 后进入价格列表：后面操作与简单散客预订操作同。  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Abce：   Ngrate：         
Best flex rate： Rack Rate：  
CORPORATE NEGOTIA…：  Wholesales： 
CORPORATE NEGOTIA…： Wholesales： 
Government for ch：  
 



3.2.3 优悦会会员预订 
优悦会会员在 OPERA 系统中有会员信息，在预订时可根据会员卡卡号确定客人；  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
　Member Type/Member No.：会员类型/会员号； 输入会员卡号后按回车，系统自动出现该会员卡持卡

人姓名，选择相应价格代码；(后面操作与简单散客预订操作同)。 
 
 Block：团队代码；在新建团队成员预订时可选择相应团队代码；  
  Member Type/Member No.：会员类型/会员号 
 　Company/CORP No.：公司/公司号；  
 　Agent/IATA No.：旅行社/旅行社号；  
 　Source/Source No.：销售员/销售员号；  
 　Show Rates：显示房价选项； 
　

 Closed：显示被关闭的房价代码；  
 Day Use：显示日用房房价代码；  
 Pseudo：显示假房  

 Room Class：酒店区域； 
 Rate Category：价格大类； 
 Rate Class：价格区域； 
 Rate Code：价格代码 
 Last Reservations：操作员本人最后建立的预订。 
 
 
 
 
 
 
 
 
 
 
 
 

 



3.2.4 预订中的特殊操作  
3.2.4.1 修改 Rate  

1.  固定整段入住期间的价格：修改价格（直接输入）→将 Fixed Rate 打勾→Fixed Rate （固定价格）

→Yes→是否针对 3 天（整段入住时间）→Yes  
2. 取消 Fixed Rate，去掉 Fixed Rate 前的勾 →Yes（只针对第 1 种的取消）  
3. 固定第一天的价格： Rate（直接输入价格）→将 Fixed Rate 打勾→Fixed Rate→Yes  

→是否针对整个入住时间→No  
   4. 修改入住期间某些天的价格代码：→   Multiple Rate Code 多重价→选中要修改的那天的价格

记录→Edit 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
→Rate code：选择要改成的价格代码； 
→Market code 是否改：是； 
→Source code 是否改：否； 
→Resv. Change Until：修改价格到哪天为止； 
→Ok：有黄色记录出现； 

5. 修改入住期间某些天的具体价格：→   Multiple Rate Code 多重价→选中要修改的那天的价格记

录→Edit  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
→Rate Amount：价格，将原来价格直接改成需要价格； 
→Fixed Rate：是否固定此价格，选 Yes； 
注：预订接口上的 Rate Code、Marked Code、Rate、Source 变成黄色，代表入住期间价格有变化。  



3.2.4.2 免费升级 

在免费升级时输入折扣金额或百分比，系统会自动算出房价金额（Rate）。如图所示 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

将 Rm. Type 中房间类型改成升级后房间类型，Rate Code 将保持原来价格不变，输入折扣金

额，实现免费升级操作。如果是更换预订房间类型，则需将 Rm. Type 和 RTC 都改成相应房间类型。  

3.2.4.3 Package 包价 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
酒店服务费、早餐、加床都在 Package 中进行设置。  

 Incl/Excl：包含/不包含；（只对默认包价有效）  
 New：建新包价；  
 Edit：编辑包价；  
 Delete：删除包价，只可删除新建的包价。  
注：团队的 Package 在 Check in 前确定，避免入住后更改造成失误。  



3.2.5 预订中 Option  
 
 
 
 
 
 
 
 
 
 
 
 

3.2.5.1 Accompanying  附随的 

 

 

 

 

 

 

 

 

 

 
用于客人的别称，如客人的名字为广东拼音--林（LAM ）;王（WONG ）等。AttachNew Name ，

查询客人资料时只要输入广东拼音的姓氏，系统设置将自动连接并显示出相应的标准拼音姓氏。多用于

快捷服务中心“Ctrl+F7”。 

Attach 添加； Detach 清除 

3.2.5.2 Add On  复制；(用于同一位客人不同时间内的预订) 
 
 
 
 
 
 
 
 
 
 
 

留意Payment 提问选项，复制完毕其中一预订需要更新姓名时，先Search Profile 查找，确认此人

之前有否Profile ，没有请选New ，否则的话，你的更改会将OriginalProfile 一同覆盖。须知，每人均

须建立有一档案，而一人是可以同时拥有两个或以上的预订。 
操作：选中要进行复制的预订→Option→Add On→Yes→Ok  
注：要修改复制出来的预订的名字，不能直接在 Profile 上修改名字，这样会将原 来的预订的名字      

也同时改掉。正确操作：选择一个预订→Profile→Search→输入名字→Search（为了避免重复建档案）

→New→Ok→Ok  



3.2.5.3 Agent/Company   公司、旅行社；可用于修改公司旅行社连接信息； 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

有协议的本地公司预订散客，此客人已有预订，可以选择RSVN －Option －Agent /Company -Profile 
Linkage －Options －Negotiated Rate 选择此公司Rate Code ；如果客人自付帐单而不享用协议价，此操

作步骤已完成，日后查询与统计该公司订房数已经计入该客人房数，此客人原预订Room Rate 不变。而

此客人享受公司协议价时，接着操作Refresh Room Rate 。 
 

3.2.5.4 Alerts    警告用语；弹出框显示； 
 
 
 
 
 
 
 
 
 
 
 
 
 
操作：New 
 
 
 
 
 
 
 
 
 
 
 
 
 
→Code→Descriptions（内容，可进行修改）→Area：选择一个显示时段；  

 Check In：入住时显示； 在 checkin 的时候跳出一次以后便不再跳出。 
 Check Out：退房结账时显示；在进入 Billing 界面时跳出 
 Reservation：每次打开预订接口都会显示；Reservation Alert 会在进入预订时提示。 

→Save→Close  
 Screen Notification：屏幕通知                    Printer Notification：打印通知 



3.2.5.5 Cancel    取消预订； 注：办理入住后此功能会屏蔽。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
      操作：点击“Cancel”→“Cancellation”对话框，选择“Reason(原因)”→“OK”。 

3.2.5.6 Billing     账务 
进入该客人入账界面；必须是已入住客人才有此功能； 

        操作：点击“Billing”→“Cashier Login”(如图)→“Billing”界面。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



3.2.5.7 Changes   预订修改记录； 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.2.5.8 Confirmation   预订确认信；  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
        Conf.Name：系统设置的文件名。 

 Send:发送 

 Preview：预览； 

 Customize：灵活的编辑功能。点击生成一张 WORD 文檔。 

 File：生成檔。会生成一个 PDF 方件。如图 

 

 

 

 

 

                                           你想更改保存到自定义的确认函 



3.2.5.9 Credit Cards    信用卡，银行界面；  

输入授权金额以及授权号码，金额输入更改输入负数金额，Manual 键操作。 
 
 
 
 
 
 
 
 
 
 
 
 
 
　

 Manual Approval：手工授权，输入授权金额、授权号；  
预订接口上的 Approval 中显示授权号及授权金额。 

注：追加授权后预订接口上显示的为总金额及最新的一次授权号。  
只有结账方式为信用卡时此功能才可操作。 

 
 
 
 
 
 
 
 
 
 
 
 Authorization Rule:PGBS 预授方式授权的授权规则。  
 
 
 
 
 
 
 
 
 
 
 
 Additional Authoriza..:PGBS 方式预授的追加预授。  
 
 
 
 
 
 
 
 
 
 Credit Card History : 信用卡历史信息 



3.2.5.10 Delete     删除预订，一般没有权限进行操作； Check in 后变灰色。 

3.2.5.11 Deposit  
预订押金；预订客人所交的押金可输入其中，当客人入住时系统将会自动将押金通过 9000 代码 转

到客人账上。 (客人在预交订金时，可以在Depost里直接输入，如客入住了可在Billing→Payment

输入)。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 New：输入要求客人预交的押金；  

 Edit：编辑要求客人预交的押金；  

 Delete：删除要求客人预交的押金； 

 Transfer：转账客人已交的押金； 

 Payment: 挂账客人已交的押金 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 订金输入后需要更正，Edit 键入，输入相同金额的负数； 
 Description 栏需要详细注明订金使用日期、用途； 
 Deposit Transfer 指预订状态下的订金转移，此预订一旦Check In ，订金转移就转 

换为Transaction Code Transfer 操作步骤了； 
 有订金的预订当天未到，视情况而定：如果延期，直接更新到达日期即可；确认 

保证预订款逾期不退，由经理确认No Show Charge （如交易会期间预订）；有订 
金的预订不认可取消预订，还可以建立并Check In 一间PM 并且将订金转至PM 
房内，由财务部应收跟进。 

 
 
 



3.2.5.12 Fixed Charges   固定收费；  
用于指定某个周期（可能是每天，每周或每月）每天固定金额的收费（TransactionCode 收费代码、

Amount 金额、Quantity 数量），固定收费必须金额与收费代码固定，夜审过房费时自动过帐。办理续

住时如仍须加收此固定收费需要重新设置。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

操作：New→  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  Once：一次；  
 　Daily：每天；  
 　Weekly：每星期；  

 　Monthly：每月；  
 　Quarterly：每季度；  
 　Yearly：每年；

  Supplement：补充 
→Trn. Code（入账代码）→Amount(金额) →Qty（数量）→Begin Date（开始时间）  
→End Date（结束时间）→Ok  

3.2.5.13 History  
历史，与 Profile 中的 History 同；  

 



3.2.5.14 Housekeeping   客房，是否开夜床； 
通知客房部做夜床（一般不用，此工作为客房部每晚必做） 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.2.5.15 Locator       客人去向。 
客人在某段时间所在的酒店区域； 客人有正在发生和还未发生的 Locator 会在预订接口上

有红色显示； 入住后，客人交待某一时间段在哪个方位或需要保密方位（Do not Disturb ）的情

况，超过截止时间后，Locator 会自动取消。时间输入为 24 小时制。DND 状态需 TakeMessage 。
Reservation 栏下有 Trace Lamp 显示。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
操作：New→ 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



3.2.5.16 Messages     留言； 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 　 ALL：全选 
   None：取消 
   Received/Not Received：收到/没有收到 

    New：新建；  
 　Delete：删除，一般不要用；  
   Print：打印 

□ Show All Messages   显示全部留言 

    操作：New→ 

 

 

 

 

 

 

 

 

 

 New---Message Text, 输入message 内容并存档，reservation 界面下方会自动出现红色Message ，表

示该客人有过一个留言。当客人反馈看到留言后，Option- Message- Message Received (如果有多条

message 便点击Received All 键), 此时预订下方红色的Message 就会自动消失，Received 的留言还

可恢复及打印。 
 提醒：留言应简明扼要，字符输入太满会影响数据库。 
 同时给多人留同一信息，先Search ，选定客人再输入信息（常用FD －Message 界面操作） 

 
 
 



3.2.5.17 Package Option    包价使用信息，查看包价消费情况，不用；  

可以查询房价含餐或其它优惠使用情况。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
     Refresh：恢复          Link：连接、联系          Report：报表 
 

3.2.5.18 Party      散客小团体；  
New Reservation→No. of Rooms→Option→Party→Add to…→Selec→Ok, 做过Party 后， 
在 Profile 旁 Group 内会有提示，分离只需 “Detach”。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Split：拆分(单项)； 　 
 Split All：拆分所有；  
 Resv. ：预订  
 Add to Party：加一个客人进入这个 Party；  
 Chg. Party：将一个客人换到另一个 Party 中； 
 Detach：把一个客人从这个 Party 中取消，与该 Party 脱离关系（预定还在）； 
操作：新建预订（房间数>1）→Save→Options→Party→Split(拆分)/Split All（全部拆分）→Edit Party（修

改名字）→如有 Profile 选择正确的，没有则用 New 新建 Profile→Ok  
注：生成 Party 后，系统会生成一个 Party 名，显示在预订接口的 Group 中，为主预订客人 的姓名。 

可用查询接口上的 Party 进行查询。  

 

 



Split：拆分(单项)； 

 

 

 

 

 

 

 

 

 

 

 
 
 
 
     Split All：拆分所有 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3.2.5.19  Privileges     特权 
 
 
 

 No Post： 
不能挂帐 

 Post Stay Charging： 
停止挂怅费用 

 
 
 
 
 
 
 
 



3.2.5.20 Rate Info.    价格信息， 
显示整个入住期间房价组成信息，默认人民币；可查看套价，服务费明细。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Currency：选择货币种类，会自动计算成该币种货币；  
Details：详细入账情况（参考作用） 
Long Info.： 
 

3.2.5.21 Register Card  

登记卡，事后打印，在预订后、入住后均可打印； 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



3.2.5.22 Room Move  换房 
 
 
 
 
 
 
 
 
 
 
 

 预订必须已经进入Checked In 状态, 已经拥有一个房号； 
 Option>Room Move, 输入想要换的房间号码（或者点下拉键可以进入Room Search界面选择，选中

新的房号）选择是否改变原来房间的房态（选择的房型默认在Room Type 第一栏），换房成功。回

到Reservation 界面后，Room Number 自动转换为新的房号。 
 如果换入房间已有客人入住，执行Room Change 时，可以直接进入Share 状态，确认付款人，Rate 

Code 。 

3.2.5.23 Routing       分单，转账；  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
        操作：New→ 
 
 Room：客人与客人间自动转账， 

主要用于团队；　 
 Windows：窗口与窗口间转账， 

用于同一个客人分窗口； 
可用于 AR 挂账； 　 

 Entire Stay：整个入住期间；  
 Other Dates：选择转账的时间， 

日期；注：包括开始 
和结束的时间。  

 Begin Date：开始时间；  
 End Date：结束时间；  
 Route to Room：选择转的房间；  
 Transactions：选择要分账的入 

账代码； 
 Status：状态。 
 From：转账记录 
 



→选择“Route to Room”下拉框(选择转的房间)→“OK”。  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 →选择“Transactions”下拉框（选择要分账的入账代码）→“OK” 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
选择相应代码，点击‘Add’添加 

 把特定的日期，特定的帐号转到相应的公司、团队或房间。 
 Room Routing 部分费用转到别的房间 

一般用于团队分帐，将各个房间的帐通过 routing 转到统一的 PM 房。FIT 的 Paid 
By 、Paid For 不做 Routing , 可以作 Party ，结帐采用 Balance Transfer （余额转帐－ 
Code ：8888 ），确保客史的完整。 

 Window Routing 在自己房间分账 
同一间房费用的分单，根据客人要求不同的费用打印不同的帐单，适用于 FIT 。 
Opera 默认第二个窗口（最多可加有 8 个窗口）。 

 Entire Stay 整个住店期间 
 Other Stay 特定的转账日期 
 Routing Code 不可重叠选择 

操作：点击 Routing →New →选择 Room Routing 或 Window Routing 以及 Entire / Other 
Dates- Route Room （选择要转入的房间号）Route to Name （要将账转给的公司名称）→ 
Routing Code （分账内容的代码，此为大项，若此大项里找不到它分账的内容，则在 
Group, Subgroup, Transaction Codes(小项)里选择→点击 Ok →Close 即可。 

 
 



3.2.5.24 Share         合住；  
 前提条件：一房最多Share 三人；入住时间必须形成交叉状态；Rate Code 必须一致；Share 的所

有预订的Fixed Rate 栏必须为空白，否则,Entire, Split , Full 等键呈阴影不可操作状态。 

 Combine: 1 Profile: 没有做预订的两个人合住 

2 Reservation: 已经存在预订的两个人合住 

 Entire:点击确认的客人名字，再点击Entire ，则表示房费由此位客人结帐。 

 Split: 点击后房费会平均分配给share 的每个预订，俗称AA 制。 

 Full: 所有预订均按原价支付，一般不操作。 

 Break share: 点击后出现输入新房间号码的输入框（点击下拉菜单可进入Room 

 Search 界面进行选择房间），被选预订已被转到新的房间，Break Share 即成功。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Room Details：房型； 
 Nightly Rate Details：每晚价格情况；  
 Share Reservation Details：显示合住人员； 

 Combine：合住；   Entire：一个全价，一个为零，选中的为全价；  
 Break Shr.：拆开；   Split：一个一半；  
 Resv.：预订；  Full：全部全价；  

操作：1、加新预订（原来没有）与当前预订合住  Combine→ 
 
 
 
 
 
 
 
 
 
 
 
 
 
→Profile→Name（输入名字）；→下拉键头→选择正确的档案或新建→OK→你是否要复制付款方式→

Yes→选择价格分配 
2、两个预订合住 Combine→Reservation（预订）→Name→ Select→Ok 
3、两个预订的房价代码不同，以第一个为准 

按 2 操作→选择一个客人→Resv.→修改价格代码与另一预订一致→OK  
注：多重价不会复制到合住的客人上，要手工改。  

 



3.2.5.25 Traces      内部留言；  
注：日期选择要处理该事件的日期；可用于总台交接，打印 Traces 报表。  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

操作：New→ 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 点击 Traces →New →选择需要留言岗位，并点击为“×”→在 Text 输入留言内容→Save →Close 
 完成 trace 后，如果再次进入 reservation 界面左下角会出现红色 trace 提示框，点击即可进入

trace 。如果 trace 事件已经收到并解决，点击 resolved 表示，reservation 的红色提示会自动消失。 
 Urgent 及 On Date 事项不用此功能键。 

 
 
 
 
 
 



3.2.5.26   Track It    跟踪 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

3.2.5.27    Waitlist  候补预订； 
将当前预订改为候补预订； 操作：做一个新预订，再按 Waitlist。 

 Reason---Priority （给所有Waitlist 客人优先排列顺序，在Reservation 的Waitlist 中会有排序名单，

一旦有房，可能接受预订，便可Accept. 
 一旦列入Waitlist ，Due In 状态转为Waitlist ，Reservation 界面呈阴影不可操作状态。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Reasons：原因； 　 
 Priority：级别；  
 Telephone No.：电话号码；  
 Description：描述。 

当酒店有空房后可用 Waitlist 中的 Accept Res.恢复为正常预订。  
 

Wake Up Call   叫醒服务；(总机)  



3.2    查询预订  

3.2.1 简单查询   Reservations→Update Reservation  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 　Name：姓名；可用模糊查询：   　Agent：旅行社；  
 　Company：公司；   　First Name：名；  
 　Group：团队；   　Corp. No：公司号；  
 　Source：销售员；   　Block：团队代码； 

  Arrival From：到店时间从⋯开始； 
注：默认为当天开始，如果去掉时间，可查出所有历史和将来的预订信息；  

 　IATA No.：旅行社号；   　To：到店时间到⋯结束；  
 　Member No.会员号；    CRS No.  
 　Conf. No.：预订号；  
 　Party：散客小团队代码，做 Party 后生成；  

操作：输入查询条件后→点击 Search→(如图) 
   界面绿色标题字段为当前排序字段。　 

注：直接单击要做排序的字段名，查询记录将根据该字段重新排序；  
 　  选择字段标题，单击右键：         

 Add this item in Order by，descending 增加该列排序（降序）默认。 
 Order by this item in descending order  为了这个项目，以递减顺序排列 
 Add this item in Order by：增加该列排序；         
 Remove this item from order by：删除该列排序；  
 Don’t order by：恢复原有排序（默认排序）； 
 Show Existing Order By：显示当前排序的顺序；  

 名字前带 * 表示该名客人与别人合住，合住人在左下角显示（蓝色）； 
 New：新建预订； 
 Check In / Cancel C/I：入住（当天入住且没有费用产生的预订才能操作）/ 取消入住； 
 Cancel / Reinstate：取消预订（取消原因→OK→取消号→OK）/恢复取消的预订； 

注：要恢复的预订的到店日期必须是今天或今天以后的，不能恢复以前的预订。  
 Profile：档案，打开当前预订客人档案；  
 Options：选项；   Search：重新回到查询界面；  
 Edit：编辑预订，与鼠标直接双击效果一样；   Close：关闭。 



3.2.2 高级查询      Advanced：高级，更多的查询条件。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Advanced Search  
 　Room Type：房间类型；  
 　Stay On：在店日期；  
  Room No.：房间号； 
 　Market Code：市场代码； 
  Res. Type：预订类型； 
 　Source Code：来源代码；  
 　Rate Code：价格代码； 

  Country：国家 
  City：城市； 
  Custom Ref.： 
  Conf. Letter：确认信 
  Credit Card #：信用卡 
  VIP：VIP 等级 
  Room Class：房间等级 

 　ETA From/ETA To：预抵时间从……到……；  
 　Rate From/Rate To：价格从……到……；  
 　Deposit Date：Deposit From/Deposit To：预订押金录入时间；预订押金从……到……；  
  Created On/Created By：何时做的预订/何人做的预订； 

 Search Type  
  General：普通；  

 Day Use：当天来当天走；  

 Due IN：预抵；  

 Due Out：预离；  

 Waitlist：候补预订 

 Cancellation：取消；  

 Checked Out 退房；  

 No Shows：预订未出现；  

 Complimentary：免费。 

 Mass Cancellation：大规模取消 

  Partial String Match：部分字符串匹配 

  Partial Condition Match：部分条件匹配 

 

 

 

 

 

 

 



3.3  候补预订  Reservations→Waitlist List 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

在接口上显示所有候补预订；可能过 Name 和 Date 进行筛选；  

 Profile：打开当前预订客人的档案；  

 View：查看预订信息；  

 Accept Res.：将该信息恢复成正常预订；  

 Cancel：取消预订。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



第四章   团队预订 
4.1 新建团队预订  

4.1.1 新建团队主预订  Reservation→Block  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

注：团队信息默认为当前在店及预订的团队；  

 　Rm Nts：总房夜数；     　Status：团队状态； 

→New：新建（客房团队与宴会团队） 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 　Acct/Comp：公司。左边框显示的是符合输入条件的档案，若连接多个公司，则可点击      ， 

公司名后的数字为Profile ID, 如果变成黄色，表示连接了多个档案)。如为协议单位 

的团队用   选择档案连接；  

 　Agent：旅行社；协议旅行社用    选择档案连接；  

 　Source：销售人员档案连接；必输项；  

 　Group：团队；不需要输入，档案将在团队预订保存后自动建立；     

  Contact：联系人    Potential：潜在的 

  Status：团队状态；  　Name：团队名；  

 　Start Date：开始日期；    Market：市场代码；根据价格代码自动生成；必输项； 

 　Nights：晚数；必输项；    Source：来源；必输项； 

  Owner：酒店销售经理；必输项  　End Date：结束日期；  

  Origin：起源   Block ID：系统自动生成 

 Status：团队状态； Tentative：不确认的； Definite：确认的； 新预订的状态默认为 TEN。 

 当在Tentative 状态下，要把整个团队取消，直接下拉菜单选择Los 键就可以取消团队了，而且此

团队不可以再激活； 

 当一个团队确认了之后，要将Reservation Type 更改为Definite ； 

 在Definite 状态下，还没有生成确认号码，如果想取消此团队就直接进入Option －Cutoff 就可以

把此团队房间清除；若生成了确认号码的团队就必须进入Reservation 给每一个预订作取消，之后

才可以进入Option －Cutoff 把团队房间清除。对于团队的更改与取消都要及时，否则影响到酒店

入住率。 

 Block Code：锁房代码；根据 Name 自动生成；必输项； 

 Res. Type：预订类型； 

 Rate Code：价格代码；必输项； 注：团队不按协议价，原来连接的协议价对团队不起用； 

 Packages：包价；此处只做说明，不影响实际  Decision Date：决定日期 

 Cut off date：停止时间（整体的）  □  Flat Rate：统一房价 

 Cut off days：按时间段确认停止时间（逐个的）  Owner：酒店销售经理 

 Follow up Date：跟进日期。针对 Sales, 提醒提前确认的最后日期 

 Elastic：伸缩性，打√表示在排房时可增加房数； 

注：规定必须选择“√”，否则不可 Overbooking，做成的预订日期也不可更改。   

 Details：详细 

 
 
 
 
 
 
 
 
 
 
 
 



 

 More：更多 

 
 
 

 

 
 
 
 
 
 

 Cancel：取消 

 

 

 

 

 

 

 

 

 

 

→Save：保存；Grid 按钮变亮，界面上出现占房表。 

4.1.2 团队预订占房    Grid：  

选择房型与日期直接在空格中输入房间数。 

 

 

 

 

 

 

 

 

 Original：最初预订锁房数；  

 Current：实际用的锁房数；  

 PickUp：用掉的房间数（已 Rooming List）  

 

 

 

 



 

 Display：显示列表    Available：可用的；Current：当前的： Rates：显示价格。 

 Currency：货币  Priorities：查看房型明细表（可用于排序） 

 Rates：显示价格。  Res.：预订分房 

 Wash：减少房间数  Details：详细 

 Range：选择房数  Close：关闭

4.1.2.1 Wash    减掉，减少房间数；  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Wash ：范围，挑选范围，日期，房型，房间数。点击Wash →By value 更改数值

 By Value：按数量减少；   Room Type：选择修改数量的房间类型；  

 By Percentage：按百分比减少；（少操作）   Advance：可选择每天减少不同的数量； 

→输入相应的 Value 或 Percentage→选择房型→OK。 

4.1.2.2 Range        选择房间数； 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 Room Type：选择房间类型；  

 □ Increase/Decrease Rooms： 

打√表示在原房间数上增减，不打√表示覆盖原 来输入的同一天的同一类型的房间数；  

 No. of Rooms：房间数；  

 Advance：可选择每天减少不同的数量 

 Cutoff Date：停止时间（整体的）  Cutoff Days：按时间段确认停止时间（逐个的） 

操作：点击Range →选择Room type →点击Increase/Decrease →在No of Rooms 处输入数量，如果是减

少数量，输入数量负数，点击OK 。 

4.1.2.3 Priorities      查看每个房型的最少可卖房情况；  

 

 

 

 

 

 

 

 

 

 

 

 

 

 Clear：清除所有排列序号；  

 Sort：按序号排序；占房界面中将按该排列顺序排序；  

注：点击要进行排序的房间类型记录，Pr.No 出现序号(1…)；点击已有序号的记录，原序号会去掉； 

4.1.2.4 Details       详细说明；  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 Pickup：用掉的房间数（已 Rooming List） 

PickUp Pct.：用掉的房间数百分比 

 Remaining： 

 Contract： 

 Released：Cut off 的房间数 

 Total Block： 

 Available：团队中还剩下可用房 

 Tent.Res.： 

 House Available： 

 House Non Deduct： 

  

4.1.3 团队预订分房 

打开新建的团队主预订  

→修改 Statue（团队状态为）Definite； 

→Save；→Resv.：预订分房； 

→Post Master reservation will be created. Would you like to continue?一个假房预订生成， 你想继续吗？  

　Yes：是； 　No：否； 

 

 

 

 

 

→Would you like to set this as a default PM to booking?你想生成一个 PM 房房号吗？  

　Yes：是； 　No：否； 　Cancel：取消；  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



4.1.3.1 快速分房 Group Option：团队选项；  

注：在进行分房操作时，必须选择 PM 假房预订记录 

 

 

 Rooming List：团队名单 
 Check In Group：团队入住 
 Room Assign：团队分房 
 Room Status：房态 
 Print Registration：打印登记表 
 New Post Master：建立新PM帐户 
 Delete：清除 
 Cut Keys：作房间钥匙 

 
 

 

 

 Rooming List：团队名单 
→Rooming List：分房名单； 

选择Rooming List ，先分一个PM 房给团队，然后按团队预定的房间类型进行分配，若Share 的房

间要注意房费的设置。 

 

 

 

 

 

 

 

 

 

 

 

→Quick Split：快速分房； 可根据实际情况输入要分房间数量。  

 

 

 

 

 

First：输入名字 

→Split→Save→Close 

 

 

 



 Room Assign：团队分房 
 

 

 

 

 

 

 

 

 

 

 

 

 

→点击“Start” 

 

 

 

 

 

 

 

 

 

 

 

 

→点击“Close” 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 Check In Group：团队入住 
 先将 PM 房 Check In，再使用团队 Check In 的功能键，Check In 该团所有的房间。 

 选择 Inspected Rooms Only - Cut Keys to all group guest - Number of Keys - Per Reservation － Don’t 

print RC －Check In 

 团体其中一房需延住，先 Block Head 延长日期，再选 This Guest Only，Routing 需相应地作延长。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

→点击“Group Option”→点击”Check In Group”。如图 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

详见团队入住操作 



 Cut Keys：作房间钥匙 

 

 

 

 

 

 

 

 

 

 

 

4.1.3.2 手工分房 

Group Option→Rooming List→按“Enter”→输入 Frist（a01、a02…..）→按键盘上的“↓”键头继续下行。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

→Save→Close  

4.1.3.3 合住分房 

Group Option→Rooming List→快速分房或手工分房分出新的预订→在预订上隔一个打‘X’ 

 

 

 

 

 

 

 

 

 

 

 



 

→Save→出现合住房价他配提示  

 　Entire Rate for Primary Sharer： 

一人全价一人零  

 　Split Rate evenly for all Sharers： 

一人一半   

 　Full Rate for all Sharers： 

全部全价  

→OK→合住客人名字前出现‘*’号，在左下角出现合住信息 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

→Close 

注：可在分房前根据占房数计算出预订数（房间数 X2），通过手工分房分出所有预订进行合住操作。  

4.1.3.4 团队分房界面其它功能  

 
 
 
 
 
 
 
 
 
 
 
 
 
 



 New：显示新的预订；  
 All：显示所有预订； 
 Traces：留言；  
 Messages：内部留言；  
 Share：合住；  

 Profile：档案；  
 Res.：预订；  
 Grids：占房；  
 Block：团队；  
 Print：打印； 

 
 Search Guest Profile：打√表示查询 Profile，不打√表示不查询，默认为不打√； 

4.1.4 其它团队分房操作  
4.1.4.1 两人住，不做合住 

操作：选中一个团队→Resv. →选中任一房间（不能为 PM 房）→Edit→Adults（人数）改为 2  
→OK  
 
 
 
 
 
 
 
 
 
 
 
 
 　This Guest Only：只是该客人；  

 　All Guests in the Group：团队中所有客人；  

 　Selected Guests：选中的客人；  

 　Only Guests with Same Arrival Date：到店日期相同的客人；  

 　All Checked In Guests：所有入住的客人；  

  Guests In House between� and�：在店日期从�到�之间； 

→根据情况选择→OK。  

4.1.4.2 团队账务转主账房   Routing 

操作：选中一个团队→Resv. →选中任一预订（不能为 PM 房）→Option→Routing→New  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



→Room→Route to Room 输入房号选择，选择当前团队假房→Transactions（要分单的项目） 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
→OK。注：Routing 详见散客预订操作。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



4.1.4.3 团队账务分界面处理   Windows(最多可以分 8 个界面) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
→NEW 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



4.1.4.4 名字修改 
操作 1：已分房后进行名字修改，不需要连接原有档案 Rooming List→All→直接对 Name 修改

→若 2 人 XXX/XXX。（可能出现重复档案） 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

操作 2：已分房后进行名字修改，要连接原有档案 Rooming List→All→Profile→通过 Profile 
Search 选择正确的档案，没有则新建（档案 选择、新建详见散客档案操作）  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



4.1.4.5 散客入团 
操作：打开散客预订→Block Code→选择要加入的团队  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
→Select 
 
 
 
 
 
 
 
 
 
→OK→系统按团队价格刷新该客人价格。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



4.1.4.6 团员出团 
操作：打开要出团的团员预订→将 Block Code, Group 中内容删除→将价格改成相应散客价格→ OK  

4.1.4.7  借房 
如果团队预订时 Elastic Block 打√，则当分房时团队所占房间数不够时系统将提示借房  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 　 House Availability：从酒店可用房中借房；  
 　 Block：从团队其它房间类型中借房  
 

4.2 团队延期 
1、 将团队主预订日期在原日期基础延长相应天数 End Date 延长 2 天→Save  
2、在团队延期那天占上相应的房间数 Grid→输入相应房间数  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



3、 给每个预订进行延期  
Resv. →选中一个预订→Edit→将到让日期修改至延期日  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Save→OK  
4、释放团队多余房间 Option→Cat off  
5、修改团队主预订日期至延期日 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



4.3 取消团队预订 
4.3.1 取消不确认团队 

在 Tentative 状态下，将 Status 状态改为 Lost Booking；  

4.3.2 取消确认团队 
在 Definite 状态下 

1、取消所有团队中成员的预订 
操作：Resv.选 PM 房预订→Cancel→输入取消原因→OK  

 
 
 
 
 
 
 
 

→Do you want cancel entire group: 你是否想取消整个团队预订 
→Yes→Are you sure: Yes→Close；  

2、将团队所占的房间释放出来  
操作：Option→Cut off→Yes  

 
 
 
 
 
 
 
 
 
 
 

3、将团队作取消操作：将 Status 状态改为 CAN。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

注：只能取消没有房间入住的团队。 
 
 
 
 
 
 



4.5 团队预订功能  
4.5.1 Option  

 
 
 
 
 
 
 
 
 
 
 
 

4.5.1.1 Add PM    增加 PM 房；  
 
 
 
 
 
 
 
 
 
 

4.5.1.2 Changes    修改记录；打开团队的操作修改记录；  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



4.5.1.3 Copy    复制一个团队,只能复制主信息界面； 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

在使用复制功能的时候不要直接按键盘的 Enter,在更改完 New Block Code 后按 OK否则团队代码将

出现中文名。  

4.5.1.4 Delete    删除；  

4.5.1.5 Deposit   预付订金；  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

操作方法同散客预订中 Deposit. 

4.5.1.6 Cutoff     把多出来的团队占房删除；  
 
 
 
 
 
 
 
 
 
 



4.5.1.7 Notes   备注；  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4.5.1.8     Item Inventory  物品租赁 
 
 
 
 
 
 
 
 
 
 
 
 

4.5.1.9     Shift Date     调整、移动团队，没有预订，时间往后推； 
 
 
 
 
 
 
 
 
 

注：只适用于还没有分房团队预订。  

4.5.1.10     Statistics  统计  
 
 
 
 
 
 
 
 
 
 
 
 
 

Block Info：打印团队汇总信息报表。 



4.5.1.11    Refr. Rates     刷新价格； 

 4.5.1.12    Traces          备注 

 4.5.1.13    Wash Schedule   洗涤清单 

4.5.2 Group Options  
 
 
 
 
 
 
 
 
 
 

4.5.2.1 Rooming List     团队分房；  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4.5.2.2 Check In Group   团队入住；只有当天预抵团队才可使用。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

详细见团队入住操作。 



4.5.2.3     Room Assign    房间分配；  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4.5.2.4     Room Status   房间状态；  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4.5.2.5 Print Registration Cards    打印登记卡 
 
 
 
 
 
 
 
 
 
 
 

4.5.2.6 New Post Master    建 PM 房；  

4.5.2.7 Delete             删除； 

4.5.2.8 Cut Keys         做房间钥匙；  
 
 
 
 
 
 
 
 



第五章 快捷键 
Miscellaneous→Show Quick Keys  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

组合方式：横向+纵向  

1. F1:        Help:                      帮助 

2. Shift+F1:  Occupancy Graph Scope:     出租率图表 

3. Ctrl+F1:   OPERA Help                 快捷键说明 

4. Shift+F2:  Control Panel:             控制面板 

5. Ctrl+F2:   Detailed Availability:     可卖房状态详情 

6. F3:        Room Search:               房间查询 

7. Shift+F3:  House Status:              当前房态 

8. Ctrl+F3:   Room Plan:                 房间平面图 

9. Ctrl+F4:   Dashboard                  导航盘 

10. F5:       Rate Query:                房价查询 

11. Shift+F5: Floor Plan:                楼层平面图 

12. F7:       New Reservation:           新的预订 

13. Shift+F7: Phone Book:                电话簿 

14. Ctrl+F7:  Operator:                  总机（查询客人历史档案）  

15. F8:       Logout:                    退出 

16. Interface Menu：Shift＋F8            做房间钥匙 

17. Ctrl+F8:  Maximum Availability:      最大可卖房 

 

 

 

 

 

 



5.1 F1：       Help 在线帮助，可跳出当前使用功能的帮助文件； 

5.2 Shift+F1： Occ. Graph     简单的酒店出租率表；  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Bar. Display：选择显示数据类型；  Start Date：开始日期；  
 Total：所有； 　  Room Type：房间类型；打 表示选中 
 Reservations：预订；   Room Class：酒店区域；  
 Blocks：团队；   Grid Lines：显示格线； 
 Non Picked Up Blocks：  Percentage：房间数量与百分比之间的切换； 

 Search：查找    Non Deducted：包括未确认预订； 
 Number of Days：横坐标每格比例；  

 
5.3 Ctrl+F1：OPERA Help    快捷键说明； 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 Change User           F8 
 Clear Field            Ctrl+U 
 Commit               F10 
 Control Panel          Shift+F2 
 Dashboard             Ctrl+F4 
 Detailed Availability     Ctrl+F2 
 Display Error           Shift+Ctrl+F1 
 Floor Plan             Shift+F5 
 Form  Help        Shift+Ctrl+PageDown 
 Function 3             Shift+Ctrl+F3 
 Function 4             Shift+Ctrl+F4 
 Function 5             Shift+Ctrl+F5 
 Function 6            Shift+Ctrl+F6 
 Function 7            Shift+Ctrl+F7 
 Function 8            Shift+Ctrl+F8 
 Function Diary         Shift+F9 
 Group Room Control    Ctrl+F5 
 House Status           Shift+F3 
 Inquiry               Shift+F4 
 Interface             Shift+F8 
 Max Availability       Ctrl+F8 

 Next Block            Shift+PageDown 
 Next Field             Tab 
 Next Record           Shift+Down 
 Occupancy Graph       Shift+F1 
 Previous Block         Ctrl+PageUp 
 Previous Field          Shift+Tab 
 Previous Record        Shift+Up 
 Quick Booking         Shift+F6 
 Quick Tack            F4 
 Rate Info              F5 
 Reservation            F7 
 Return                Return 
 Room Plan            Ctrl+F3 
 Scroll Down           PageDown 
 Scroll Up             PageUp 
 Show Keys            Ctrl+F1 
 Tack Navigator         F6 
 Telephone             Shift+F7 
 Telephone Operator     Ctrl+F7 
 Vacant Rooms         F3 

 
5.4 Shift+F2：Control Panel    控制面板；  

点击 Search： 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 Total Physical Rooms：              实际总房间数；  
 Out of Order：                     坏房；  
 Inventory Rooms：                 可出租房（前两项之差）  
 Overbooking：                    允许超预订房间数；  
 Sell Limits：                      整个酒店卖房上限；  
 Deducted Blk. Rooms Not P/U：      确认团队锁房未分数；  
 Deducted Block Rooms P/U：        确认团队预订已分房间数；  
 Total Deducted Rooms：            确认预订房间数（包括散客和团队） 
 Non Deducted Blk. Rms Not P/U：   未确认团队未分预订；  
 Non Deducted Blk. Rms P/U：       未确认团队已分预订；  
 Total Non Deducted Rooms：       所有没有确认团队用房（锁房）  
 Out of Service：                  暂停服务房（不从可出租房中扣除）；  
 Available Physical Rooms：        实际剩下可卖房；  
 Maximum Availability：           最多剩下可卖房；  
 Minimum Availability：           最少剩下可卖房；  
 Min. Occupancy %：             最小出租率；确认预订/实际可卖房；  
 Max. Occupancy %：             最大出租率；所有预订/实际可卖房；  
 Total Rooms Reserved：          实际预订总数，要减掉未分房（Not PM）  
 Event：                        重要活动 
 Day Type：                     日期类型 
 Adults In-House：                在店成人数；  
 Children In-House：              在店客儿童数；  
 People In-House：                在店客人数；  
 Arrival Rooms：                 预抵房间数；  
 Arrival Persons：                预抵人数；  
 Departure Rooms：              预离房间数；  
 Departure Persons：              预离人数；  
 Day Rooms/Persons：            日用房数/人数；  
 Waitlist rooms/Persons：          候补预订房间数/人数；  
 
 Blocks：团队，显示所有在店的团队和当天发生的团队；  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Details：详情；  



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Waitlist：候补预订；  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



5.5 Ctrl+F2：Det. Avail   显示每个房型在将来每天的可卖房情况；  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 　Start Date：开始日期；  
 　Room Class：酒店区域；  
 　Include Non Deducted：打√表示包括不确认的预订（一般为不确认团队）；  
 　Include Overbooking：打√表示包含可超额订房间数；不打√为实际房间数，默认为打√； 
  Include OOO：打√表示不包含严重坏房，默认为打√； 

   Total：整个酒店剩下的可卖房数量；  
   RC Total：该区域剩下的可卖房数量；  
 　Search：刷新；  
 　Details：预订详情； 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



选中某天点击 Details，出现预订详情；每个房型的每种预订类型的预订数（不同房型的各 种预订

类型的分类）；用于查看客房预订结构。可在客房紧张时对预订情况进行分析。 
 Arrivals：抵店； 　  Day Type：日历； 
 Departures：离店；  Event：活动，会议，宴会； 
 Adults：成人数；   Day Use Rooms：日用房     Persons：人数 
 Children：儿童数； Wailtlist Rooms：候补预订    Persons：人数 
 OOS Rooms：轻微坏房；可用下拉键头查看详细信息；  
 OOO Rooms：严重坏房；  
 Total Hotel Avail：整个酒店可卖房，  
 Max. Avail：最大可卖房；  
 Min. Avail：最小可卖房；与最大区别在于未确认预订；  
 House Obkg.：酒店总的超预订；  

 Occupancy：占房情况/ Availability：汇总信息；注：此选项是互相切换的。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Blocks：查看当天发生的团队。与选中日期有关，住过选中的日期；  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Initial：最初占房数；  Block：实际现在占房多少间； 
 Status：团队状态；  P/U：分了多少间； 
 Block：查看团队主信息；  %：分房用掉的占所占房数的百分比； 
 Res.：查看预订；  Avail： 剩余多少间没分； 

 
 



 Zoom In  放大（详细） 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5.6  F3：Available Room Search 
可用房查询，具体房间，只能查询，不能排房；  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Date：日期；  
 Days：天数； 
 Room Class：酒店区域；  
 Room Type：房间类型；  
 Floor：楼层； 
 Smoking：吸烟房；  
 Features ：房间特点；  
 □ Incl. Pseudo Rooms：包括假房 

 Due Out：预离； 
 Checked Out：已退房；  
 Connection Rooms：连通房 
 Clean Rooms：干净房；  
 Dirty Rooms：脏房；  
 Out of Order：严重坏房 
 Inspected：已检查 
 Out of Service：轻微坏房； 

 



5.7 Shift+F3：House Status   房间状态；  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Room Summary：  

 Total Hotel Rooms：总房数；  
 Out of Order：严重坏房；按下拉键可查看详细信息；  
 Total Rooms to Sell：可卖房数；  
 Out of Service：轻微坏房；  

 Activity：总台进出情况；  
 Stayovers：过夜房；注：不是今天到也不是今天走；  
 Departures Expected：实际预离；  
 Departures Actual：实际离开；  
 Arrivals Expected：实际预抵；  
 Arrivals Actual：实际到店；  
 Extended Stays：续住；  
 Early Departures：提前离店；  
 Day Rooms：日用房，当天来，当天走；  
 Walk Ins：上门散客； 

 Complimentary and House Use：免费和内部使用 
 Complimentary Arrivals：免费使用抵店 
 Stayovers：过夜房 
 Departures：离店 
 House Use Arrivals：内部使用抵店 



 Stayovers：过夜房 
 Departures：离店 

 End of Day Projection：夜审  
 Min. Available Tonight：最少可用房；  
 Max. Occupied Tonight：最多住房，包括未确认预订房间数；  
 Max. % Occupied Tonight：最大出租率；  
 Blocks not Picked Up：团队占房未分的房间数；还没有被 Rooming List 的房间 数，正常应保证为零；  
 Individuals：散客；  
 Groups & Blocks：团队&锁房；  

 Housekeeping Status：客房部状态； 　 
 OCC/VAC：有人住 / 没人住； 　 
 Clean Rooms：干净房； 　 
 Dirty Rooms：脏房；  
 Out of Order Rooms：严重坏房；  
 Out of Service Rooms：轻微坏房；  

 Search：刷新；  

5.8 Ctrl+F3：Room Plan 房间列表；  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
输入筛选项： Start Date：开始日期                  □ Vertical Zoom：垂直缩放 
             Room Type：房间类型                 □ Horizontal Zoom：水平缩放 

Room Class：酒店区域；              □ Component Rooms： 
Rooms：房号； 　 
Floor：房间楼层 
Room Features：房间特色； 
Smoking：是否吸烟房；  

 Type：房间类型；  
 Status：房间状态；  
 双键头：表示在哪天退房；可通过鼠标延伸离店日期；  

注：不同颜色代表不同的市场代码； 

 
 



5.9      Ctrl+F4:Dashboard  导航盘 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Searching option: 
Searching by: Room Number / Name / Confirmation Number /Advanced column 
Reports option 
Housekeeping function 
 Reservation option: 
Cancel reservation 
Change reservation 
Check in the guest 
Reservation option 
 New Reservation 
 Cashiering Option 
Balance showed 
Payment showed 
View charge function 
 Calendar 
 
 
 
 
 
 
 
 



5.10 F5：Rate Query   价格查询。  
 
 
 Rate Query： 

价格列表，可用于新建预订； 
 Rates By Room Number/Type： 

查询价格； 
 Package Elements： 

包价查询； 
 Rate Availability Grid： 
    价格有效期查询； 
 Item Inventory： 

单项明细 
 
 

5.11 Shift+F5：Floor Plan   楼层图。 
 
 
 
 
 
 
 
 
 
 
 选择要查看的楼层，View 查看  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Out of Service：暂停服务房  Clean：干净房 
 Occupied：在住房  Dirty：脏房 
 Expected arrival：预抵房间  Inspected：已检查过的房间  

 Out of Order：坏房 
 



5.12 F7：New Resv.      新建散客预订 

5.13 Shift+F7：Telephone Book   系统黄页；  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 　Category：大类；  
 　Remarks：备注；  
 　New：新建；根据当前鼠标所在位置新建大类或明细；  
 　Print：打印，选中一个大类，打印该大类下所有详细信息；  
 　Edit：编辑；  
 　Preview：预览；  
 　Partial Name Search：明细查询；可用‘%’；  
 　Category Search：大类查询。  

5.14 Ctrl+F7：Telephone OPERAtor 总机查询功能； 点击 Search：  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 All Guests：显示所有客人；  
 Arrivals：预抵客人；  
 Stay overs：住店客人；  
 Departures：离店客人；  
 T. OPERAtor：总机房查询用；  
 Include No Shows：包含该到未到客人；  
 Include Check Outs：包含已退房客人； 



5.15   F8：Logout   用户切换。 
 
 
 
 
 
 
 
 
 
 
 
 
 

切换到登录状态，用于操作员切换。 

5.16 Shift+F8：IFC Menu   与其它系统连接的程序（接口程序） 
 
 
 
 
 
 Room Status： 

房间状态；  
 Group Bar/Unbar： 

分类选项/删除选项 
 Keys： 

钥匙接口 
 
 
 
 
 Room Status： 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 Group Bar/Unbar： 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Keys 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Duplicate：复制，重复。 

 
5.17 Ctrl+F8：Maximum Availability 一段时间内最多可卖房数；  

点击 Search 选择 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



第六章 Front Desk 前台 

1. Arrivals………………………入住 

2. In House Gusts……………….在店客人查询 

3. Accounts……………………...酒店 PM（假房）帐号 

4. Room Assignment……………锁房(分房) 

5. Message………………………客人留言 

6. Trace………………………….内部留言 

6.1 排房功能    Room Assignment 
Front Desk→Room Assignment 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
→输筛选项查找符合要求的记录： 
 Date：日期；   Room Class： 

 Name：姓名；   Block：锁房代码；  

 Room Type：房间类型；   Specials：特殊要求；  

 Group：团队名；   Smoking：是否吸烟房；  

 Room Features：房间特色；   VIP：贵宾等级； 

 Res. Type：预订类型  Advanced；高级 

 Auto: 电脑自动选房，一般用于团队。 

 Advanced；：高级 



 
 
 
 
 
 
 
 Rate Code：价格代码；  
 Company：公司；  
 Agent：旅行社；  
 ETA From：到店日期从；  
 ETA Time To：到店日期至：  

 Party：散客小团体代码；  
 Market Code：市场代码；  
 Length of Stay：在店天数；  
 Incl. Blocked Res.：打√表示显示

包含已排过房的预订； 
6.1.1 手工排房 

→选中要排房的记录 
→Assign：排房；注：也可通过 Assign 来换房；(弹出“Room Assign”界面) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
→选择房间(选择“Inspected”)→OK 



6.1.2 取消排房  
Front Desk→Room Assignment→选择要取消的记录（已排房） 

→Un Assign：取消排房；  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6.1.3 自动排房 
Front Desk→Room Assignment→选择要排房的记录（可通过筛选条件选择） 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



→Auto：自动排房； 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Assign：排房；   Room Class： 

 Unassign：取消排房； 

注：将取消所有当天符合条件的已

排房(一般不用)；  

 Dirty Rooms：脏房； 

 Clean Rooms：干净房；  

 Inspected Rooms:已检查房 

 Arrival Date：到店日期；   Include Due Out Rooms： 

包括预离房；   Room Type：房间类型；   

 Features：特点；   Include Out of Service Rooms： 

包括暂停服务房；   Smoking：是否吸烟房；  

 Use Associated Preferences:  Floor：楼层；  

 Start from Room：开始房间； 

→Start：排房； 
 
 
 
 
 
 
 
 
 
 
 
 



→Close：关闭→完成。如图所示 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6.1.4 团队自动排房  
Reservations→Blocks→选择要进行排房的团队→Edit 

→Resv.→GroupOption→Room Assign：自动排房 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

→输入排房条件→Save→Close.  

注：Room Assign 中的 Unassign 只取消该团队的所有已排房间。 



6.2 前台入住  
6.2.1 预订散客入住   Front Desk→Arrivals 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

→输入筛选项进行选择→Search→选择要入住的记录 

 Advanced 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



6.2.1.1 直接入住 
Check In：入住；如未排房，出现排房界面。如排房了直接 Check In。 

 

 

 

 

 

 

 

 

 

 

 

 Room：房号；系统自动显示一个当前可用房，下面蓝色显示其它可选房，

可直接输入这些房号，也可用下拉键头选择其它符合条件的房间；  

 Method Of Payment：付款方式； 必填项 

 Credit Card No.：信用卡号；  

 Expiration Date：信用卡有效期； 

→OK；  

 Check In: 电脑会自动选择房号，并于下方给出另外 5 间可供选择的房号。 

6.2.1.2 编辑查看后入住 

Edit：打开预订； 

 

 

 

 

 

 

 

 

 

 

 

 

 



鼠标单击 Room 旁边的下拉框，自动排房，左下角出现其它可用房→OK  

 

 

 

 

 

→Yes                            →OK 

6.2.2 上门散客入住    Front Desk→Arrivals→Walk In 
        6.2.2.1 确认没有预订 

   询问客人是否有预订，确定没有预订情况下→Front Desk→Arrivals 

 

 

 

 

 

 

 

 

 

 

 

 

Arrivals→输入宾客姓名→没有档案则新建，有档案选中→选择价格代码→

OK→Resv.进入预订操作→选择房间、输入客人资料(操作与散客预订相同) 

 

 

 

 

 

 

 

 

 

 

 



→OK  

 

 

 

→Yes 

 

→记录预订号 

注：Walk In 操作一定要一次性完成，分次完成将变成一个 Check In 客人。 

6.2.2.2 不确认是否有预订 

询问客人是否有预订，在不确认情况下→Front Desk→Arrivals→输入客人

姓名进行查询→有预订，则进行预订客人入住。没有出现预订未找到 

 Reservation not found, what would you like to  
预定未找到，是否做上门散客入住 

 Search other Dates 

查询其它到店日期 

 Perform a Walk in  

执行 walk in 

 Perform another Search 

执行其他搜索 

 

→选择“Perform a Walk in”→OK→按 6.2.2.1 上门散客入住操作。 

6.2.3 团队入住  

Reservations→Blocks→选择要入住的团队→Edit→Resv.→Group Option→

Check In Group：团队入住； 

 

 

 

 

 

 

 

 

 

 

 



 Cleck In  
 Clean Rooms Only：只是干净房；  

 All Rooms：所有房间；  

 Inspected Rooms only：只是已检查的房间。 

 Clean or Inspected Rooms：干净房和已检查的房间。 

 Cut Keys 
 Cut keys to all group guests：所有客人做钥匙；  

 Prompt for each group guest：每个客人都提示； 
 Do not print keys to any guest in this group：所有该团队客人都不做钥匙；  

 Number of Keys 
 Per Reservation □：每个预订的房卡数量 

 Per Adult Per Reservation：每个预订的成人数来做房卡。 

 Print Registration Card 
 Print registration cards to all group guests：打印所有客人登记表；  

 Prompt for each group guest：每个客人都提示； 

 Don not print registration cards to any guest in this group：不打印；  

→Check In→Close.  

6.2.4 假房入住   Accounts 

Front Desk→Accounts：假房入住； 

 客人在酒店消费，但不在酒店住宿，客人要求打印帐单，可从此做假房。 
 Accounts 的另外一种用途：客人在外不能及时回酒店办退房，但要求先把帐单准备好，

此时可做PF ，将客人原有房间的帐目转到PF 上，再将原房间退掉。 

 

 

 

 

 

 

 

 

 Room Type (PF)： 

PM －Posting Master 
PF －Permanent Folio 
PQ －Banquet Event Posting 
PY －House Use 



 Name：名字；必须在 Profile 中 Search；  

 First Name：姓；  

 Date From：开始日期；  

 Date To  ：结束日期；  

 Room Type：房间类型；PM/PF；  

 Room：房号；  

 Rate Code：房价代码 

 Marked Code：市场代码； 

 Source Code：客源代码； 

→OK 注：要求夜审在做 PF（）假房入住时，将预定中的价格代码设置为 NR。 

6.2.5 入住后换房 

打开预订→Option→Room Move 

 

 

 

 

 

 

 

 
可通过下拉键头选取同类其它房间；注：如果选择其它类型房间，系统做为免费升级； 

→OK。 

 

 

 

 

 

 

将房间状态改为已检查房/ 干净房/脏房？Inspected\Clean\Dirty。 

 

 

 

 

 



6.3 在店客人查询  
Front Desk→In-House Guest  

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Room No.：房号；   First Name：姓名，英文名；  

 Name：姓名；   Agent：旅行社；  

 Company：公司；   Block：团队；  

 Group：团队；   Party：散客小团体；  

 Source：来源，销售员；   Advanced：高级； 

 Advanced：高级 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 Arrival Date From/To:到店日期；  

 Departure Date From/To:离店日期； 

 Country：国家；  

 Room Type：房间类型；  

 VIP Status：贵宾等级；  

 Market Code：市场代码；  

 Arrival Time From/To：到店时间  

 Member No.：会员号；  

 City：城市  

 Res. Type：预订类型；  

 Source Code：客源代码；  

 Rate Code：价格代码；  

 Conf No.：预订号；  

 General：普通；  

 Day Use：日用房；  

 Checked Out：已退房；  

 Due Out：预离房；  

 Complimentary：免费房； 

 
6.4   取消入住 

Front Desk→In House Guests→选择要取消的记录 

 

 

 

 

 

 

 

 

 

 

 

 
→Cancel C/I→是否要取消入住→Yes. 注：只能取消当天入住，且没有费用发生的记录。 

 

 

 

 

 
(Do you want to block room?是否要保留房号) 当客人有消费后便不可取消入住。 

 

 

 

 

 

 



6.5  批量留言  Messages 
6.5.1   新建批量留言 Front Desk→Messages 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Received：已收到；  Print：打印留言； 

→New。 

 

 

 

 

 

 

 

 

 

 

 

→选择需要留言的对象→OK。 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

→输入留言的内容 

 



6.5.2 Display Messages：查看留言；  

→点击“Messages”→选择查看的对象→点击“Edit”。如图 

 

 

 

 

 

 

 

 

 

6.6   内部留言   Trace 
6.6.1  新建内部留言 Front Desk→Trace  

 

 

 

 

 

 

 

 

 

 

 

 　Resolved：已解决的留言； 

→New。 

 

 

 

 

 

 

 

 

 



→选择需要留言的对象→OK。 

 

 

 

 

 

 

 

 

 

 

 

→Department：留言部门→输入留言内容→Save 

6.6.2 查看内部留言 

→点击“Traces”→选择查看的对象→点击“Edit”。如图 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



第七章  HOUSEKEEPING 客房部 

7.1 修改房态  

Room Management→Housekeeping  

 
 
 
 
 
 
 
 
 
 

 Housekeeping Management………….客房管理 
 Room Conditions…………………….房间展示 
 Room Discrepancies…………………矛盾房 
 Task Assignment…………………….任务委派 
 

 Housekeeping Management………….客房管理 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 FO States：前台状态； 　  Room States：房间状态； 　 
 Vacant：空的；   Clean：干净；  
 Occupied：占用的，有人住  Dirty：脏；  
 Select All：全选；  Inspected：已检查房； 
 Clear All：全清；  Out of Order：坏房；  
  Out of Server：暂停服务房； 



 Advanced：高级选项； 
 
 
 
 
 
 
 
 
 

 Arrivals：预抵； 　 
 Arrived：已到店；  
 Stay Over：在店； 
 Day Use：日用房(当天来当天走)； 
 Due Out：预离；  

 Departed：已离店；  
 Not Reserved：纯空房，没有预订； 
 Floor：楼层 
 AM： 
 PM： 

 Details：房间详情 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Room：房号，为光标当前选中的房间； 
 Room Type：房间类型； 
 Description：描述；  
 Published Rate Code:出版房价代码 
 Published Rate Amount：出版房价数量 
 Max.Occupancy:最大出租率  
 Features: 房间特色 
 Component Rooms:房间结构 
 Display Sequence:显示次序 
 Connecting Rooms;连通房 
 Room Class：房间级别 
 Floor Preference：楼层首选项 

 Smoking Preference：吸烟首选项 
 Phone Number：电话号码 
 Square Units:平面单位 
 Measurement: 尺寸 
 Key Code:关键代码 
 Key Options:关键菜单 

 Housekeeping 
 Day Section 
 Evening Section 
 Stayover Credits 
 Departure Credits 

 



 

 Details Statisitcs：详细统计数据 
 Statisitcs 

   Room Status： 

   FO Status： 

   HK Status： 

   Persone： 

 From Fiscal Start Date 

 Room Revenue： 

 Extra Revenue： 

 Room Arrivale： 

 Days Occupied： 

 Person Nights： 

 Statistics  统计数据 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Total Rooms 
 Total Clean 
 Total Dirty 
 Total Inspacted 
 Total Out of order 
 Total Out of service 
 Not Reserved-clean 

 Not Reserved-Dirty 
 Not Reserved-Inspected 
 Not Reserved-Out of Service 
 Reserved-Clean 
 Reserved-Dirty 
 Reserved-Inspected 
 Reserved-Out of Service 

 
 
 



 
 Change：修改房态，可批量修改；  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Room List：房间列表；点击下拉键头可选择要修改的房间； 　 

 From Room⋯ To⋯：房间号从⋯到⋯；  
 Section：可选楼层；  

 Change Status to：将房间状态修改为⋯；  

 Room Conditions…………………….房间展示 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 New 新建 

 

 

 

 

 

 

 

 

 

 

 Room Discrepancies…………………矛盾房 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Sleeps：有人住；  
 Skips：逃帐；  
 Person Discrepancy：人数矛盾 

 

 

 

 

 



 Task Assignment…………………….任务委派 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Auto Assign：自动排房；  
 Complete：所有工作表 

 New 新建 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



7.2  封停房  

Room Management→Housekeeping→Out of Order/Server  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Edit:：编辑  Details :详细 
 Delete：删除  Resv.：预订 
 Close：关闭  Copy：复制，原因、时间段均相同；  

 New：新建封停房； 
 

 New：新建封停房； 
 
 
 
 
 
 
 
 
 
 
 
                                                              新建成功提示信息 
 
 Room List：房间列表；点击下拉键头可选择要封闭的房间；  

 From Room⋯ To Room⋯：房间号从⋯到⋯；  
 From Date：开始日期；  
 Through Date：结束日期；日期头和尾都包含在内；  
 Status：选择设为 OO/OS；  
 Return Status：恢复后房态；一般为脏房；  
 Reason：原因；  
 Remarks：手工输入原因（中文）  



 Edit：修改，可做延长；  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

延长：修改时间 
 Copy：复制，原因、时间段均相同 

 
 
 
 
 
 
 
 
 

 Delete：删除, 提前释放； 
 
 
 
 
 
 
 
 
 
 
 
                                               删除成功提示信息 

 



7.3   房间历史  
Room Management→Room History→输入房间号码后 Search  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Profile：打开档案；  Revenue：收益 
 Resv.：预订  Folio：打开历史账单 
 

 Revenue：收益 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Room Revenue： 
 Extra Revenue： 
 F&B Revenue： 
 Payment： 
 
 



 Folio：打开历史账单 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
→Folio 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
. 

7.4 可超预订房间  
Room Management→Overbooking 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 Physical：查看各房型房间数；  
 New：新建可超预订房间数；  

 Edit：编辑；  
 Delete：删除 

 

 New：新建可超预订房间数 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Overbook Level：超额数量 
 Room Class：房间级别 
 Room Type ：房间类型  

 Number：数量 
 Percentage：百分比 

 

 Physical：查看各房型房间数 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

7.5 出租率图表 Occupancy Graph (略)  
 



第八章 Cashiering 收银 
8.1 收银  
Cashiering→Billing  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
→输入收银密码；  
 Cashier No：收银员号；  
 Password：密码；与登陆密码同；  
→Login；如为当天第一次登陆收银操作，系统将出现下面对话框； 
 
 
 
 
 
 
 
 
                                  你想打开收银吗？ 
→Yes； 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



→根据筛选条件进行查询： 
 Company：公司；   Room：房号；  

 Stay Overs：在店客人；   Name：姓名；  

 Due Outs：预离；   Block：团队代号；  

 Arrivals：预抵；   Group：团名；  

 Checked Out：已退房  Party：散客小团体代码；  

→选择客人后双击或点 Select       注：最多可允许 3 个人同时打开同一账户。 

 dvanced 高级选项 
 

 

 

 

 

Open Balance:                Cancellations:              Open Folio：                   

8.1.1 收银界面说明  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Group：团队；   Balance：总余额；  
 Rate Code：价格代码；   Status：状态；  
 Rate：房价；   Arrival：到店时间；  
 蓝色提示：Cashier Comments，可单击打开  Depart：离店时间；  

 Company：公司；  

 明细栏上标题： 
 
 
 
 Date：日期；   Description：描述；  
 Code：入账代码；   Amount：消费金额 
 Supplement：账目信息备注，手工输入账目的一些备注信息；  
 Reference：账目单据备注，手工输入或者系统自动生成； 

用于存放单据号及操作痕迹，不能修改； 　 
 +：账单相同的号记录合并显示，双击“+”可展开成明细；展开后双击“-”可合并；  



8.1.2 Post：入账； 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
输入账单：  
 Code：入账代码；  

输入代码方法： 1、点击下拉菜单选择相应代码  
2、直接输入代码 
3、输入代码前几位，按 Tab 键  
4、输入描述，可用‘%’；  

 Code 1 ××× ：Room Revenue                    房费收入代码 
 Code 2 ××× - 3 ××× ：F&B Revenue          餐饮收入代码 
 Code 4 ××× - 5 ××× ：Other Operating Revenue 其他营业收入代码 
 Code 8 ××× ：Adjust                          调整 
 Code 9 ××× ：Payment                         付款 
 Code ××88 ：(on Revenue Code) Manual Post       手工入帐 
 Code ××99 ：(on Revenue Code) Rebate            帐务减免 
 Code8000 ：Paid Out         现金支付 
 Code8001 ：Deposit Refund   订金退款 
 Code8002 ：Cash Advance    预支现金（信用卡提现） 
 Code8010 ：Unicef Donation   联合国儿童金捐赠 
 Code8888 ：Balance Transfer     余额转帐（适用P/B & P/F ） 
 Code8899 ：Paid Out Commission  预支现金手续费（5 ％） 
 Code9100 ：Cash     现金 
 Code9104 ：Cheque   支票 

 Code92 ××：Credit Card   信用卡付款 
 Code9300 ：City Ledger     挂帐 

 Paid Out ：现金支付 
收回客人押金单，核对Deposit 与Paid Out 两者签名是否一致；不一致的话，争取获得押金交付

客人的授权函；或者得到部门经理批准复制结算客人的有效证件及获取其申明，在Opera →Profile
→Note 中备注以便日后查询。 

 Cash Advance ：预支现金 
前提必须是住店客人,并且须得到部门经理批准,视情况而定(备用金额度)有限额；交易进行时,

别忘记须收取5%的手续费并入帐至相应的交易代码(＃8899), 交易(预支现金与手续费之和)必须

现结,不可挂房帐； 

紧急事故预支现金不支持此操作，由大堂经理执行现金报销程序，先行 House Bank 中支付。 

*Westin 不支持 Cash Advance from Credit Card, 建议客人使用大堂的 ATM 机。 



 Cashier Report ：收银员报表 
Code “1xxx”－“5xxx”（收入交易代码）出现在报表时，意味着“凭证在哪”，否则财务部门

同事事后得问你要了； 

Code “8xxx”（调整交易代码）是否经理须批示； 

Code “xx99 ”（交易减免代码）必须是经理批准的，“Surcharge ”No Discount ； 

Code “92xx”（前台信用卡交易代码）,而“POS Credit Card”－Infrasys 的信用卡交易代码。 

 Balance Transfer ：余额转帐 
入住时确认好 Paid By （被付款人）和 Paid For （付款人）关系，获取 Paid For 的付款承诺

书，明确付款项目（“All of Charges” or “Part of Charges”）及支付期间,为保持客史统计数

据的完整性，不建议“Routing ”操作，因此退房采取余额转帐； 
Paid By 先行退房时，请打印其消费明细帐单让其预览并确认签名，帐单转Paid For帐袋中； 

对于多间房Paid By 和Paid For 关系的客人还可以用“Party ”组合，提醒查询与退房结算。 

 City Ledger ：挂帐 
首先需要建立有AR Account （应收帐号），接着Option →Routing→Window →Profile→Linkage 

– Company / Agent / Booking Center- “All of Charge” or “Part of Charge” (Routing Code) ；

挂帐房间宜先结算个人帐部分。 

 Post －入帐 
 帐务需一笔一笔入，Check No#（帐单号）系统打印帐单号，手写单输入印刷品单号，Supplement 
（附录）简明扼要； 

 Transaction Code 栏可输入Transaction Group 的英文开头字母进行模糊查询； 
 选定Transaction Code 后Arrangement Code 自动默认，不可私自更改此栏； 
 若Check No.相同，系统会将两笔费用归类在第一个Transaction Code 中，屏幕出现“＋”双击

即可显示明细。 
 Description：描述；  
 Amount：金额；  
 Qty：数量；  
 Win：窗口，默认为 1；  
 Arr. Code：合并账单代码，做假账用；  

 Check No.：账单号；同一账单号的记录会自

动合并显示；  
 Supplement：备注；  
 Reference：系统备注 

注：如果为 No Post 则在 Post 时会提示 
 
 
 
 
 
 
 
 
 
 

金额大于等于 500 元时会提示。  
 
 
 
 
 
 
 
 
 



8.1.3 Edit：编辑，查看；  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Cashier：收银员号； 
 Folio No.：账单号； 
 Posting Date：入账时间，实际时间 

 Revenue Date：入账 OPERA 系统时间 
 Supplement：备注 
 Reference：系统备注 

8.1.4 Folio ：打印账单；  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 From Date：开始日期；如已结过账，则日期从上次结账后开始。  

 To Date：结束日期；  

 Summary by Check No. (Date)(14)：当前账单格式。  

 Folio Style：账单格式 

Edit Post 更改帐务 
更改帐务条件为：当天，同一交易代码，同一金额，同一收银员代码，更改方法为：更改 

帐务数量（负一笔，非负数金额），原因须附上。 
 



 Folio Style：账单格式； 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
1、 明细；  
2、 根据入账代码合并（每天的相同代码合并）； 
3、 根据入账代码合并（入住的整段时间）； 
4、 根据 Arr. Code 合并账单（每天）； 
5、 根据 Arr. Code 合并账单（入住的整段时间）； 
6、 一天一行； 
13、按 Arr. Code 合并；  
14、按 Check No 合并；  
 
 
 

 

 

 

 

 

 

 

 

 

 

 



8.1.5 Option  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Post Rate Code：入账价格代码；  Agent/Company：公司/旅行社；  
 Posting History：入账历史；  Changes：修改记录 
 Privileges：特别待遇  Credit Cards：信用卡，预授权代码、金额； 
 Profile：档案；  Deposit：订金 
 Reservation：预订；  Fixed Charges：固定收费； 
 Room Move：换房  Folio History：历史账单 
 Routing：分单；  Package Options：包价信息； 
 Disable Phone：隐藏电话号码，默认：Enable。  Phone Details：显示所有电话费用； 

 
保存 Routing 后提示： 

 

 

 

 

 

是否更新账单？ 
Yes：所有更新；No：以前不更新，Routing 以后发生的按要求分账 

8.1.6 Payment：付款，入押金；  
 

 

 

 

 

 

 

 

 

 

 Payment Code：入账代码；   Currency：货币，付款方式 

 Amount：总数，默认当前窗口余额，根据实际情况输入金额； 注：输入押金显示为负数。即要退 

还给客人的。 

 Reference：备注； 



8.1.7 Settlement/Check Out：付款，结帐； 
 预离房房现 Check Out,直接点击 Check Out，根据实际情况结账退房即可。  

 非预离房出现 Settlement。 

 

 

→点击“Settlement”→ 

 

 
 
 
 
 
 
 Interim Bill：暂结账，不退房；付款方式默认预订时设置； 

 等同 Payment 操作，结算当前帐单，此操作可连接帐单打印选择。  

 Early Departure：提前退房结账，提前离店；  

 当天Check In 房间，Option －Reservation －Room Nights －“0 ”－OK-Settlement －Early 

Departure －Post Room and Tax ，让系统遵循Rate Code 过房费； 

 Walk In 房间禁Room Nights －“0 ”，因为一旦选择，退出预定后，进入Billing 客人Folio 时

将自动遵循Rate Code 过一晚房费；即使客人出租房间为日用房性质， Room Nights 必须是“1”。 
 当天Check In 或者Walk In 房间提前离店，收取折扣房费，Option －Reservation-Room 

Nights-“0”-Discount (Amount or “%”)-Discount Reason-OK ；避免手工算房费出错，建议采用遵

循Rate Code 系统过房费方法为佳。 

 Room Nights －“o” 完成后，Room Rate 处点击直接更改房价，或者下拉菜单选择Refresh Rate 功

能键更改房价，建议不采用此方法。 

 完成 Early Departure 后可在“Shift ＋F3 ”－Activity 框可查询。 

注：只要用过提前离店不论是否完成，状态都会变成当天预离。  

 Advance Bill：追加房费，提前结账；  

→点击“Advance Bill”→ 

 

 Tonight：追加当天房费；  

 Entire Stay：后面有几晚加几晚； 

注：最好不用，会影响平均房价。 

 

 

 Settlement→Advance Bill→Fixed Charges→“Tonight “ or “Entire Stay ” →Payment→

“Post ” or “Close ” 

 选择好预过房费的期间（今晚或入住期间），如果只是预先试算房费消费不结算，选择Close 键；

而如果客人需要预付房费在内的帐单，选择Post 键，结算的金额为当前客人消费总额（含刚滚过

的房费在内）。 

 Advance Bill 一旦操作，房费（一晚或多晚）将提前过帐，系统夜审时不会再有房费过帐。 

 一般情况下，不建议选择“Entire Stay ”，首先影响当晚的平均房价（Shift ＋F3 －End of Day 

Projection 框可查询），再者可能会出现客人提前离店而将减免房费。 
 
 
 
 



8.1.8 右键  
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 单项记录右键 

Transfer to window…………………………………转帐至另一窗口 

New window……………………………………………新建窗口 

Delete window…………………………………………删除窗口 

Screen View…………………………………………屏幕预览 

View summarized transcations……………………预览交易汇总 

Delete Transaction…………………………………删除费用 

Split Transaction…………………………………拆分金额 

Adjust Transaction…………………………………调整费用 

Transfer Transaction………………………………转账 

Add Guest View………………………………………添加客人预览 

Remve Guest View……………………………………移动客人预览 

Next Guest……………………………………………下一个客账 

Previous Guest………………………………………上一个客账 

POS check Details…………………………………营业点帐单明细 

 明细栏上标题右键 

Add this item in order by………………………添加排序，升 

Add this item in order by, descending………添加排序，降 

Order by this item in descending order………这个项目秩序降序 

Remove this item from order by…………………删除此项排序 

Default order………………………………………默认顺序 

Show existing order by……………………………显示现有顺序 



8.1.8.1 Transfer to window   转帐至另一窗口 

        将帐务转到其它窗口中，如没有指定的窗口会自动新建 window 窗口 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

8.1.8.2 New window    新建窗口 

8.1.8.3 Delete window   删除窗口 

8.1.8.4 Screen View   屏幕预览 

选择窗口显示；  
 Full：全屏显示；  
 Split：平分两个窗口；  
 Quad：四个窗口； 
 

8.1.8.5 View summarized transcations   预览交易汇总 

 

 

 

 

 

 

 



8.1.8.6 Delete Transaction   删除费用 

8.1.8.7 Split Transaction   拆分金额 
 Amount：固定金额；  

 Percentage：百分比；  

注：拆分后不能合。 

 

8.1.8.8 Adjust Transaction   调整费用 

 Acjust Selected Postings 

 Acjust Selected Trn.Codes 

 Acjust Selected Check No. 

8.1.8.9 Transfer Transaction   转账 

 
 
 
 
 
 
 
 
 
 
 
 
 
 Transfer To another Room：转到其它房间； 

 Transfer From another Room：从其它房间转入；  

 Transfer From List of Rooms：从一批房间内转入； 

 Grouped Postings：转整类费用 

操作：选择要转的房间号码，Select 选择类， 
 
 
 
 
 
 
 

 Transaction Code(s)：选择要转移的代码；  

 Inclusive：打√表示包含的，要转的；  

 Period…To…：时间段；  

 Entire Folio：转全部所有账单记录；  
 All Marked Postings/ Individually Select：打标记的费用转账； 注：转一条不需打标记  
 Partial Posting：调整转账，把费用拆分的同时转掉一笔； 



操作：输入要分转的房间号码→Selects→选择要拆分并转移的费用→点击 Split + Transfer→出现 
Split（拆分金额）界面 
 

 

 

 

 

 

 

 

 

 

 

 

 

→按照 Split（拆分金额）进行操作→OK。 注：输入的数字代表被转的费用。  

8.1.8.10 Add Guest View   添加客人预览 
增加打开另一个客人账单 

8.1.8.11 Remve Guest View   移动客人预览 
关闭窗口；将当前客人收银窗口关闭。 

8.1.8.12 Next Guest   下一个客账 
客人账单间切换至下一个客账； 

8.1.8.13 Previous Guest  上一个客账 
客人账单间切换至上一个客账； 

8.1.8.14 POS check Details  营业点帐单明细 

8.2  快速入账  
Cashiering→Fast Posting 

 

 

 

 

 

 

 

 

 

 

 

 

 

 比 Post 入账多一个 Room，下一条的房号与入账代码会默认上一条记录，输入一条记录后，No Post
不会弹出提示。  

 不用进入客人房间帐单的入帐，下栏处有不间断输入的合计金额、笔数。 

 关注左下方如果有蓝色“No Post”显示, 意味着该客人没有足够押金可挂房帐，同时栏目上方有 

“Balance ”显示，如果继续输入房帐，记得随后马上追收押金。 



8.3    收银功能  
Cashiering→Cashier Functions  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Batch Folios：      批量打印账单 
 Batch Postings：    批量入账 
 Cashier Reports：    收银员报表； 
 Cashier Status：     收银员状态； 
 Currency Calc.：     外币兑换计算 
 Currency Exchange： 外币兑换 
 Exchange Rate：     汇率 
 Folio History：      账单历史 
 Journal：           查账，对账工具(日记帐) 
 Deposit：           押金/取消 
 Receipt History：     收据历史 

8.3.1 Batch Folios 批量打印账单；  
 Folios for Guests Departing Tomorrow 

 

 Folios for Guests Departing Today 

 

 Folio for Guest Departing Today 

 

 Folios for All Guests 

 

 Folio for One Guest 

 

 Store Unprinted Folios in Folio h… 

 

 Folio for Guest Departed Yesterday 
 
 



 

 

 

 

 

 

 

 

 

                                         →Next 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

                                        →Next 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

                                        →Next 

 

 

 

 



→Next 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

→选择对象→Print (单项打印)/Print All(打印全部) 

8.3.2    Batch Postings：    批量入账 
同一交易代码，同一交易金额，同时入账不同房间，可以选择此功能键。 

8.3.3   Cashier Reports   收银员报表；只能查看本人的收银员报表。 

 

 Cash Report：现金报表；  
 Check Report：支票报表；    
 Foreign Currency Report： 

外币兑换报表； 

 Credit Card Report： 

信用卡报表； 

 AR Settlements Report： 

应收报表； 

 Miscellaneous Payments Report： 

其它付款方式报表； 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



8.3.4 Cashier Status    收银员状态；显示所有未关帐的收银员；  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

8.3.5 Currency Calc.   货币兑换计算；只计算，不计账；  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Exchange Code：兑换类型代码；  Amount：金额； 

 To Currency：兑换成的货币；  Date：日期 

 From Currency：被兑换的货币； 
 



8.3.6 Currency Exchange    货币兑换；  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Room No.：房号；  
 Name：姓名；  
 Currency Code：兑换货币代码；  

 Exchange Code：兑换类型代码；  
 Amount：金额；  
 Supplement：备注，输入兑换水单单号； 

 仅对住店客人服务，除非得到部门总监批准的（非住店但为酒店消费客人）； 
 Exchange Code 栏有Cash 和Check 必选项； 
 手工操作须知：旅行支票兑换有0.75 ％的贴息率须扣除；外币钞票运用现钞率，旅行支票运

用现汇率； 

 外币兑换操作不显示在 Billing 内，可通过收银报表或者是 Receipt History 栏查询； 

8.3.7 Exchange Rate     汇率，兑换率； 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



8.3.8 Folio History   账单历史；生成时间为结账时间或暂结账时间。  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Receipt Type ：Currency Exchange Cash ；Currency Exchange Check ；Deposit ；Paid Out ； 

Payment可以选项查询明细。 

Folio 打开账单，可选择账单格式； 

8.3.9 Journal      查询，对账工具；  
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Cashier No.：收银员号； 
Transaction Code：入账代码； 
Arrangement Code：调整代码； 
List of Rooms：房号列表； 
Reference No.：备注； 
Date From/To：日期从…/至… 
 
 



8.3.10   Deposit/Cancellation  押金/取消； 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

8.3.11 Receipt History   收据历史； 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



8.4 关账 Cashiering→Cashier Shift Functions 

每位收银员至多可以开关收银帐三次。 

 

 

 

 

 

 

 

 

 Cashier Shift Close   

 Cashier Shift Report    

 Reprint Reports       

 Cashier Shift Close 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

→Details:详细 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

核对每项记录，可用 Details 查看每项明细 

核对每项记录，可用 Details 查看每项明细； 
 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Cash：现金收入；  
Paid Out：现金退款；  
Total Cash Drop：合计现金收入；  
Checks：支票； 
注：现金合计为负数，不可以关账，要求在 General Cashier（内部银行）内借款平账后才能进行关帐。 

注：关账后系统打印关账报告，如果关账报告由于某种原因未能打印出来，将无法再次打印。 一天的

关账次数最多为 3 次。 

8.5    快速结账  Cashiering→Quick Check Out 
适用于团体 Check Out Zero 房间，即快速将 PM 中 Balance 为零房间先行退房。 

 
 
 
 
 
 
 
 
 
 
 
 
 
只显示当天预离房。 

 Select All：所有都结账；  
 Billing：进入 Billing 界面；  
 C/O Zero：零余额结账；所有零余额客人全部结账；  

注：当天来当天走（日用房）不属于零余额房，主要用于团队客人结账。  
 Select：选择要退的房直接退房 
 



8.6 特殊结账及调整参考  
8.6.1 Check Out  

1、散客当天预离，余额大于 0  

根据预订中的付款方式结账  

2、散客当天预离，余额小于 0  

Posting →8000 退余额→结账  

Posting →8000 退所有押金→用新的付款方式结账  

3、散客当天预离，余额临时挂账，余额大于 0  
用 8500 代码 Posting 与余额相同的一正一负两笔 
→Transfer 正数到 9601PF 前台临时挂 账短款→房间零余额结账  

4、散客当天预离，余额临时挂账，余额小于 0  
用 8500 代码 Posting 与余额相同的一正一负两笔→ 
Transfer 负数到 9602PF 前台临时挂 账长款→房间零余额结账 

5、散客预离，城市挂账挂公司或旅行社  
Option→ Windows Routing 到有 AR 账号的公司或旅行社档案→城市挂账结账  

6、散客预离，由其它客人付 
（客人 A 为客人 B 付款）分别打印客人 A 和客人 B 的账单→ 

Transfer 客人 B的所有费用到客人 A→客人 B 结账（余额 0）→根据付款方式为客人 A 结账。  

（客人 A 为客人 B 付款）分别打印客人 A 和客人 B 的账单→在客人 B 中用 8500 入 一正一负两笔余额→  

Transfer 客人 B 余额到客人 A→客 B结账（余额 0）→根据付款方式为客人 A 结账  

7、散客白天用房结账 
当打开客人账单时系统自动入一笔房费→根据付款方式结账  

8、散客明天预离，提前结账  
Settlement→Advance Bill→入当晚房费→按账单支付（没有退房）  

9、散客提前结账退房 
客人提前到当天走：Settlement→ Early Departure→系统自动入一笔房费→根据付款方式结账 
客人住超过一晚：Settlement → Early Departure →要根据付款方式结账  
延迟退房：Posting→ post 延迟房费及服务费→进行同上操作  

10、散客结清帐，不退房  
Settlement→Interim Bill→根据付款方式结帐。（没有退房） 
结帐过程系统不会抛房费，只是对客人当前已有的费用结算。  

11、团队结账 
团队成员有余额：Cashiering→Billing→选择房间→根据付款方式结账 
团队成员没有余额：Cashiering→Quick Check Out→C/O Zero  
团队主单结账：Cashiering→Billing→选择房间→根据付款方式结账  

8.6.2 调整  
1、错账调整  当时：用原代码入负数做冲减； 事后：用 9 结尾代码入负数做减免；  
2、漏结 Reinstate 恢复已结账→‘Y’→‘ No’→Post 漏结的费用→用付款方式结账 
3、结账后改结账方式 

其它结账改城市挂账结：恢复结账 Reinstate→‘Yes’ →‘No’ →‘原付款方式调整→城市挂账结 

城市挂账用其它结账方式结：恢复结账 Reinstate→‘Yes’→‘No’→Payment 正确的付款→用城市挂账结  
4、 关账，收入大于 0 打印 FI14 报表→核对当天入账及收入→Close Cashier→‘Ok’→‘Yes’ →‘Yes’→‘Ok’  

5、关账，收入小于 0  
打印 FI14 报表→ 核对当天入账及收入→ Cashiering → Cashier Functions →General Cashier → 
Transfer from the amount of due back → Close Cashier → ‘Ok’→‘Yes’→‘Yes’→‘Ok’→  

 
 



第九章 AR 应收 

1、Account Maintenance                账户维护 

2、Transfer F/O Data                  (中间地带)前台挂账转移 

3、Credit Cards                       (中间地带)信用卡数据 

4、Research                           挂账调查 

5、Statement History                  历史声明 

6、Traces                             跟踪 

7、Batch Processing                   批处理 

9.1   账户维护  Account Maintenance 

    9.1.1 账户查询  AR→Account Maintenance  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 All：         显示所有  Account Name:     账户名 

 Open Balance：显示带余额账户  From Account No.：账户从... 

 No Balance：  显示余额为零的账户  To Account No.：  账户叫至... 

 Account Type：    账户类型 

 Options：选项  New：新建 

 Delete：删除  Select：选择 

 



9.1.2  新建账户  AR→Account Maintenance 

→New→档案查询→选择正确的档案→OK→账户设置界面 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Account Type：账户类型；2 个代码；  
 Account Number：账户代码；AA9999 格式，不能重复；  
 Credit Limit：信用额，限额；必输项 注：超过限额时前台挂账时会出现提示，可生成限额报表。 

 Status：状态； □ Flagged : 
 Contact：联系人；  

 Phone/Fax：电话/传真；  
 Email：邮箱地址 

 AR Address：地址，档案中的地址会自动复制过来，修改后不影响档案中地址；  
 City：城市 
 Postal Code：邮编 

 Country/State：国家/省份 
 Reference Currency：货币；人民币；  

 Include In Batch Stmt：打√表示包含在批量打印日结单；  
 Permanent Account：打√表示该账户为永久账户，不可删除； 
→OK。 (查看各账户的具体内容，可在查询界面里“双击”进入，如下图) 
 

 

 

 

 

 

 

 

 

 

 

 建立AR Account 路径有： 
 Profile →Profile Search (New or Edit)→View By (选择Profile Type)→Account (建立账户)→ 

Address需要详细输入,日后邮寄帐单地址以此界面地址为依据→Statistic &Information→AR 栏下拉

菜单→Setup Account 操作界面→Account Type→Account Number （前两位为字母，后六位为数字）

→Credit Limit 信贷限额(提示City Ledger Settlement)→Reference Currency 默认人民币→OK→OK 
 AR→ Account Maintenance→ AR Account Search→New→ Profile Search→接下来步骤同上。 

 Delete AR Account 
 光标停留在所选帐号，点击Edit→Setup Account 界面→Permanent Account 点除勾号→OK

→Delete 。 

 AR Account 有 Balance 的帐号无法操作 Delete 键（呈阴影状态） 



 AR Post 调整金额 

 光标停留在所选帐号，Select －AR Account －Detail – Post – 接下来步骤同Billing栏Post 键 

 一旦操作将影响 Trail Balance Report 与 Aging 帐龄 

 

9.1.3 账户操作 

9.1.3.1 账户界面说明 

AR→Account Maintenance→选择要进行处理的账户（可同时选择多个账户）→Select→点击“Detaile”。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Up to：账龄；Up to 30:30 天以内；31-60：31 天-60 天 

 明细标题说明： 
 Date：挂账日期，实际发生日期；  

 Amount：金额（原始的）；  

 Open：余额；  

 Paid：冲减；  

 Supplement：增补 

 Reference：备注； 

 Accounts Balance：总余额；  

 Payment Only：打√表示只显示冲账记录；  

 All：显示所有记录；  

 Open：只显示带余额的记录； 

9.1.3.2 压缩账 Compress    适用于信用卡 

合并，一笔以上，当天的费用不能合并； 

注：1、被合并的账不能是被冲减过的； 

2、合并后名字变成账户名； 

3、合并后有“+”， “+”是真正的费用，下面两笔只是信息；  

4、可用右键 Uncompress 拆开，只能是当天的才能进行拆分。 

 可压缩更改的错帐（正负两笔）及同一性质付款； 

 查询框点击“All ”，压缩后的帐呈“＋”状态隐藏，点击即可显示明细 

 操作前提为：只是Invoices （非Payment ）可操作，不支持Paid Invoices ，同一Current Day 的

Posting 。 



9.1.3．3 Invoice  发票明细；  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

9.1.3．4 Edit 查看账户信息;  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Amount：金额；  

 Paid：冲账金额，0 代表没有冲过账；  

 Open Amount：余额；  

 Cashier：收银员； 



9.1.3．5 New   加一次客人的消费记录，可入账；  

New Invoice, Transfer FO/Data 转移完毕出现丢失时，先求助IT 查找，得到确认后再操作此功能键。 
 

 

 

 

 

 

 

 

 

 

 

 

→”OK” 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

9.1.3．6   Parment  冲账 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Payment→Payment Code→Currency→Amount→Supplement→Post ；适用单笔或部分帐款支付。 



 Payment Code：入账代码；  
 Currency：付款方式；  
 Amount：金额；  

 Supplement Info：补充信息；  
 Reference：备注； 

 Unallocated Payment：无去向的账，不是用于冲账，如押金、预付；  
 Apply payment to oldest charges：从最早的账开始冲；  
 Apply payment to marked charges：冲选中的记录，打 X 的；  
 Apply payment selectively：有选择性的自由分配冲账；  

 Deposit or Payment 
 Unallocated Payment －Payment Code －Currency －Amount －Supplement －Reference 

－Post ；此款项将入到该应收帐号内，不会抵冲任何挂帐。 
 需要从Deposit 中结算账户内的挂帐：“×”选中Deposit Amount 栏及需 支付帐务栏 －

Pay －付款步骤如上。 
 Back Charge Payment ：点击右键－Unapply －选中－Unapply ，Open栏将 恢复Balance 。 
 在黄色查询框点击Open 为所有余额账户显示；点击Payment Only 为已付款账户显示。 
 Deposit Cancel ：点击右键－Reverse Payment 。 

 Apply Payment to Oldest Charges ：支付最早账户，如有剩余金额将自动冲抵其他应 
 Apply Payment to Marked Charges 。 
 Apply Payment Selectively ：在 Apply 栏直接输入应付款。 

9.1.3．7 Option   功能选项；  
 

 

 

 

 

 

 

 

 

 

 

 

 

9.1.3.7．1 Account Setup    账户设置，修改； 
 

 

 

 

 

 

 

 

 

 

 

 

 



9.1.3.7.2   Aging   账龄； 
 

 

 

 

 

 

 

 

 

 

 

 

 Aging 栏：“Up to 30, 30-60,60-90,90-120 ”显示Open (Balance)栏中的数据帐龄； 

月末的帐龄越小意味着酒店收入越大，因此 Open 栏中的数据不可超过 90 天 Pay ，此为信贷规定 

9.1.3.7．3   Folio History  历史账单；  
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

9.1.3.7.4 Future Resv.    将来预订；  
 

 

 

 

 

 

 

 

 

 

 

 

 



9.1.3.7.5 Notes    备注；  
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

9.1.3.7.6 Pay History 付款历史；  
 

 

 

 

 

 

 

 

 

 

 

 

 

 

9.1.3.7.7 Post History   入账历史；  
 

 

 

 

 

 

 

 

 

 

 

 

 

 Pay History & Post History 同等 Profile & Reservation 的“Changes”键。 



9.1.3.7.8 Profile  档案；  

9.1.3.7.9 Statement  对账单；  
 

 

 

 

 

 

 

 

 

 

 

Balance Forward From⋯ To⋯：这段时间的费用合并起来打印； Promo Text：可输入短语； 

 Statement －Promo Text （发送短信），输入后显示在月结单左下方。 

9.1.3.7.10 Transfer   转账； 
 

 

 

 

 

 

 

 

 

 

 

 

注：1、冲过的不能转； 2、合并过的不能转；3、负数最好不要转；  

具体步骤：Transfer (Payment)：Payment 入错账户，需转入正确的账户，光标选中Payment→点击

右键→Unapply→Unapply→Pay→Payment Code (9804→AR Inter Transfer)→Select the “AR Inter 

Transfer”→Option→Transfer→Transfer Search (AR Account Search)→OK→Yes 。 

9.1.3.7.11 Year View  查看从当天前一年的账户情况； 
 

 

 

 

 

 

 

 

 

 

 

 

　      Debits：发生额； 　Credits：冲账； 　Balance：余额；  



9.2    前台挂账转移    AR→Transfer F/O Data  
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 明细标题说明: 

 Folio No.：前台账单号；   Account Name：账户名；  
 Invoice No.：应收查询单号；   Account No.：账户号码；  

 Name：客人名；   From Date⋯ To Date⋯：日期从⋯到⋯，To 默
认为前一天  Date：日期；  

 Amount：总金额；  
 

9.2.1   Edit 
 

 

 
 
 
 
 

 

 

 
 
 
 
 
 
 
 

→选择正确的账号→OK  



9.2.2 Details   账单明细；  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 右键菜单： 

 Edit：每笔明细详细记录；  
 Delete：删除明细纪录；  
 Pos check Details：POS 详细检查；  

 Edit：每笔明细详细记录 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



9.2.3 Transfer 转移； 

选中一笔转一笔，两笔打 X 转两笔；/转移所有；多项为合并转移。  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

9.2.4 Folio 账单  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



9．3  信用卡数据 Credit Cards (中间地带)信用卡数据 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 Transfer FO/Data & Credit Card 
 每晚夜审后，Transfer FO/Data 与Credit Card 数据库生成，如果不转移会累加帐龄； 

 Transfer Accruals to AR→Edit→支持更改挂错公司、旅行社或订房中心等的名称； 

 Transfer 完成后Trail Balance Report 中将反映出来，下一步骤进入Account  Maintenance 

9．4  挂账查询  Research  

 

 

 

 

 

 

 

 

 

 

 

 

 



9.5 Statement History 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

9.6 Traces  内部留言 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



9.7  批处理  Batch Processing 
 

 Remainder Letters：生成对账单 
 Statements：成批打印所有月结单 
 

 

 

 

 

 Remainder Letters：生成对账单 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Generate:生成 

 Statements：成批打印所有月结单 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



9.8  成批入账  Batch Posting 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Commission 佣金 
 Payment Processing 处理付款 

 Payment Activity 付款行动 

 Research 调查 

 Commission 路径 
 Rate Code ：Setup→Rate Management→ Rate Code →Rate Setup →“Commission ”

－Linkage to Transaction Code （Transaction / Package Transaction Code ） 

 Profile ：Profile Search －Profile Type (Agent)→Statistic & Information →Bank 

Account→ Commission 

 “In house guest”→ Advance search →Rate Code （选定有Commission Code 的）

–Reservation Form→“Profile ”栏的Agent (Linkage)Commission ，此状态选择不同

的Commission Code 冲突了，系统默认Rate Code 优先选择。 

 Setup Commission Code 
 Setup→ System Configuration →Commission→ Commission Code →New 

 按照百分比设置：Commission code 输入百分比- Description- Sequence→ Commission Based on→ 

Revenue→ New- Commission Code Transaction –选择－OK －Tick the “Based on Net Amount→ 

Commission Amount→ OK→  Hold Status→ Tick “Always”→ Reservation History Records －

Commission Paid on “Per Night ”& “Percentage ”→OK 

 

 

 

 



第十章 其它杂项 

Reports……………………………………报表 
Reports Scheduler………………………..调整报表 
Interfaces………………………………….后台接口 
Show Quick Keys…………………………快捷键 
Change Password…………………………更改密码 
Data Extraction…………………………...提取数据 
Track It……………………………………跟踪日记 
Log Book…………………………………..日志 
Enrollment………………………………...申请会员 
Lookup…………………………………….查找会员 
Print Tasks………………………………...设置打印 
User Activity Log…………………………查询操作记录 
File Export………………………………..文件导出 
File Download…………………………….文件下载 
Registration Cards………………………..登记卡 
10.1  Reports    报表 
Miscellaneous→Report 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 Report Group   报表分组  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Accounts Receivable：               应收账款报表 
Arrival：                          到店客人报表 
Blocks and Groups：                团队报表 
Configuration：                    配置报表 
Dashboard：                      导航报表 
Departure：                       离店客人报表 
Financial：                       财务报表 
Forecast：                        预测分折报表 
Guests in House：                  在店客人报表 
Housekeeping：                    客房报表 
Profile：                         档案报表 
Reservation：                     预订报表 
Shift Reports：                    交班报表 
Statistical：                       统计报表 
Yield Management：               收益管理报表 
 
 



10.2  Reports Scheduler   调整报表 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
10.3  Interfaces  后台接口 
 
 
 
 
 
 
 
 
 
 Interface Sub Menu: 接口子菜单 
 
 
 
 Room Status 
 Group Bar/Unbar 
 Keys 
 
 
 
 
 
 



→Room Status 
 
 
 
 
 
 
 
 
 
 
 
 
→Group Bar/Unbar 
 
 
 
 
 
 
 
 
 
 
 
 
→Keys 
 
 
 
 
 
 
 
 
 
 
 
 Duplicate:复制 



10.4   Show Quick Keys 快捷键 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
10.5    Change Password    更改密码 
 
 
 
 
 
 
 
 
 
 
10.6   Data Extraction    提取数据 
 
 
 
 
 
 
 Data Extraction Query：数据提取查询 
 Extract Results：提取结果 
 



 Data Extraction Query：数据提取查询 
 
 
 
 
 
 
 
 
 
 
 
 

 Process：过程 
 Extract Results：提取结果 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
10.7   Track It           跟踪日记 
 
 
 Dashboard：导航板 
 Valet：服务员 
 
 
 
 
 



 Valet：服务员 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
10.8   Log Book          日志 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
10.9   Enrollment        申请会员 
10.10  Lookup           查找会员 
10.11  Print Tasks        设置打印(打印任务的设置) 



10.11.1  添加打印机 
在设置打印机任务之前，先添加打印机，步骤如下： 

→Setup→Configuration→Setup→Printers→New。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
→New 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
→Physical Device(选择打印机)→输入 Description(描述)→Ok。 



10.11.2  添加打印任务 
→Setup→Configuration→Setup→Workstations  

(或→Miscellaneous→Print Tasks) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
→Printer(选择打印机)→Print Task(选择打印任务)→Ok。 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



10.11.3  删除打印任务 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
选择打印任务→点击“Delete”。快捷方法：一边按“Delete”,一边按空格。 

10.12  User Activity Log   查询操作记录 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



10.13  File Export        文件导出 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
10.14  File Download      文件下载 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



10.15  Registration Cards   登记卡 
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